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In questa Guida...

Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.4)

Questa guida all'uso contiene istruzioni su come avviare,
utilizzare, risolvere i problemi e sottoporre a manutenzione
lo scanner per microarray Agilent.

Introduzione

Questo capitolo descrive lo scanner per microarray e la
preparazione necessaria per il suo funzionamento.

Operazioni preliminari

In questo capitolo viene spiegato come utilizzare in sicurezza
lo scanner per microarray e come preparare ed effettuare la
scansione dei vetrini con il programma Agilent Scan Control.

Modifica delle impostazioni di scansione

Informazioni sul funzionamento delle impostazioni di
scansione e su come e quando modificarle.

Utilizzo degli strumenti

In questo capitolo viene spiegato come impostare i profili —
gruppi di impostazioni di scansione — regioni di scansione e
tempi di accensione/spegnimento automatici del laser.

Manutenzione e risoluzione dei problemi del sistema

In questo capitolo vengono descritte procedure e consigli per
la manutenzione, e messaggi di errore per la risoluzione dei
problemi del sistema.

Consultazione

Questo capitolo presenta le specifiche per i vetrini e fornisce
informazioni di ottemperanza alle normative.
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Questo capitolo contiene un'introduzione generale allo
Agilent G2565CA Scanner per microarray

Uno strumento  Questa sezione descrive le caratteristiche che rendono lo
potente... scanner per microarray uno strumento potente nella
soluzione di studio dei microarray di Agilent.

Descrizione del In questa sezione vengono illustrate le caratteristiche
sistema hardware e software dello scanner per microarray, le parti e
i requisiti di sistema, informazioni sulla preparazione del
sito e le linee guida per la sicurezza.

Principidi Questa sezione spiega il funzionamento dello scanner per
funzionamento  microarray.

Agilent Technologies
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Introduzione

Uno strumento importante per lo studio dei microarray

10

Lo Scanner per microarray Agilent G2565CA fa parte della
soluzione di studio dei microarray di Agilent Technologies.
Lo scanner per microarray € un sofisticato scanner di
fluorescenza indotta da laser concepito per leggere i
microarray stampati su vetrini standard da 1" x 3".

Lo scanner per microarray misura l'intensita della
fluorescenza del campione di acido nucleico marcato (DNA e
RNA) legato ai microarray. La sua capacita di misurare
simultaneamente la fluorescenza da due colorazioni facilita
tutti gli studi di microarray a due colori. Questa tecnologia
garantisce una scansione dei microarray rapida, di elevata
qualita ed automatica.

Figura 1 Scanner per microarray Agilent G2565CA

Ogni vetrino viene scansito nel giro di pochi minuti e i file
vengono preparati per l'analisi.
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Descrizione del sistema

In

Introduzione 1

questa sezione vengono elencate le funzioni hardware e

software, componenti e requisiti del computer, una
descrizione fisica dello scanner e informazioni sulla
preparazione del sito e sulla sicurezza.

Funzioni hardware e software

Lo scanner per microarray offre le seguenti funzioni:

Lettura interna ed esterna del codice a barre
Auto-focus dinamico

Calibrazione automatica con guadagno di PMT prima di
ogni scansione

Stabilizzazione continua della potenza laser
Dimensioni dei pixel pari a 2, 3, 5 o 10 micron

Intervallo dinamico di >10% per una scansione singola in
modalita di scansione a 16 bit, >10° per una scansione
singola in modalita di scansione a 20 bit e >10% per una
scansione doppia in modalita di scansione a 16 bit (XDR)
Compressione dei file di immagine TIFF

Specifica di uniformita di <6% CV (Coefficiente di variazione)

Il software Scan Control consente di selezionare i canali di
colorazione (fluorescenza), le regioni di scansione, la
risoluzione, l'intervallo dinamico, il guadagno di PMT e le
cartelle di output per ciascuno dei vetrini nel ciclo del
caricatore. Queste impostazioni possono essere caricate
automaticamente da profili specifici per applicazione o
possono essere selezionate singolarmente.

Elenco dei com

ponenti

Lo scanner per microarray Agilent G2565CA comprende i
seguenti componenti:

Scanner per microarray
Caricatore circolare e 50 portavetrini
Stazione di lavoro con software di ripristino su CD

Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.4) 11



1 Introduzione

e Cavi di alimentazione e USB

e Software Scan Control 8.4

¢ Software Feature Extraction 10.x

¢ Dichiarazione di Conformita

Il software Agilent Scan Control 8.4 € progettato per 1'uso
con il software Agilent Feature Extraction 9.5 e successive
versioni. Le scansioni a 5 e 10 micron, a 16 bit, offrono

compatibilita retroattiva con FE 9.5. Le scansioni a 2 e 3
micron, e tutte le scansioni a 20 bit, richiedono FE 10.x.

Requisiti del computer

Prima di installare e utilizzare il software Agilent Scan
Control, verificare che siano presenti i seguenti elementi:

Software
e Windows XP Professional con SP2 o Windows Vista 32
con SP1

¢ Internet Explorer 5.5 o una versione successiva

Hardware

¢ Pentium IV a 3,2 GHz o superiore
* Richiesti 2 GB di RAM (4 GB di RAM se il software

Feature Extraction e installato sullo stesso PC)

e 250 GB di spazio disponibile su disco per i programmi e
la generazione dei dati

12 Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.4)



Introduzione 1

Descrizione fisica dello scanner

Vista frontale dello scanner

Bocca del filtro dell'aria
e porta di accesso

Coperchio
Indicatori /
luminosi : .
. V/i

di stato i A\ =—7 L8

m e :00

°-9o,

Interruttore __| ———T L]
di accensione [

Figura 2 Scanner per microarray, vista frontale

Vista dall'alto dello scanner

Braccio di caricamento

Coperchio automatico del portavetrini

Etichetta
informativa

Base di supporto
del caricatore
circolare

Figura 3 Scanner per microarray, vista dall'alto
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1 Introduzione

Vista posteriore dello scanner

Bocca dell'aria

F % i i Portafusibili di
alimentazione

Tensione di rete
/ finestrella indicatrice

? N

/ \
o \
Connessione USB

Portafusibile del laser

Impostazione della
tensione di rete

Presa di alimentazione

Figura 4 Scanner per microarray, vista posteriore

Preparazione del sito

Verificare che I'ambiente soddisfi
le “Specifiche dello scanner per
microarray” a pagina 96 contenute
nel Capitolo 6. In caso di domande,
contattare il centro vendita e
assistenza Agilent locale oppure
visitare il sito

www.agilent.com/chem/ Assicurarsi

dnasupport. che il _
coperchio
abbia spazio a
sufficienza

Posizionare l'unita

su un tavolo di D— '5* h

laboratorio o su un
piano robusto. T
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Introduzione 1

Simboli di sicurezza sullo scanner
A Simbolo di ATTENZIONE

Il simbolo di ATTENZIONE & posto sul prodotto quando &
necessario fare riferimento alla guida del prodotto per
comprendere un potenziale pericolo. L'avviso richiama
l'attenzione su una procedura operativa, una prassi o
comunque un'azione che, se non eseguita correttamente o
attenendosi scrupolosamente alle indicazioni, potrebbe
comportare danni al prodotto o la perdita di dati importanti.

Simbolo di AVWERTENZA

11 simbolo di AVVERTENZA é posto sul prodotto all’interno
dell’area in cui & presente una tensione pericolosa oppure
quando esiste il rischio di scosse elettriche. In quest’area
deve operare solo personale di assistenza addestrato.

Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.4) 15
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Introduzione

Linee guida di sicurezza

Lo scanner per microarray Agilent G2565CA e stato
concepito per un impiego semplice e sicuro. Assicurarsi di
comprendere e osservare tutte le avvertenze e gli avvisi
prima di azionare lo scanner per microarray.

Non tentare di riparare o accedere ai componenti interni dello scanner

AVVERTENZA ) e . . . ..
per microarray. Esiste il rischio di esporsi ad alta tensione e a radiazioni
laser pericolose. La rimozione delle coperture invalida la garanzia.

AVVERTENZA Lo_ scanne_r per mlcroar_ray deve essere collega_to auna ‘sorgente dl-
alimentazione dotata di messa a terra. Per la sicurezza é necessaria

una messa a terra di protezione.

Quando si accende lo scanner per microarray per la prima volta oppure
si trasferisce I'unita in un nuovo sito, verificare che I'impostazione
della tensione sia corretta e che vi sia il collegamento "a terra".

Agilent raccomanda di posizionare lo scanner per microarray su un
tavolo di laboratorio o un piano robusto. Lo scanner per microarray &
una potenziale fonte di vibrazione ed é potenzialmente sensibile alla
vibrazione esterna.

Lo scanner per microarray & potenzialmente sensibile alle condizioni di
umidita con generazione di condensa. Seguire le precauzioni indicate
nella documentazione del prodotto. Vedere “Consigli per evitare
problemi” a pagina 71 del capitolo 5 e le relative specifiche di umidita a
pagina 96 del capitolo 6.
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Introduzione 1

Principi di funzionamento

Questa sezione descrive le caratteristiche di funzionamento
dello scanner per microarray Agilent G2565CA.

Posizionamento dei vetrini

Lo scanner per microarray ospita fino a 48 vetrini da 1" x 3"
in un caricatore circolare rimovibile. Durante un ciclo del
caricatore, i vetrini vengono trasportati in sequenza nella
posizione di scansione, ne viene effettuata la scansione e
quindi vengono riposti nel caricatore.

Eccitazione laser

Scansione

Lo scanner per microarray utilizza due laser, un laser
SHG-YAG (532 nm) e un laser elio-neon (633 nm). I laser
eccitano I'RNA o il DNA marcato con cianina-3 (Cy-3) e
cianina 5 (Cy-5) per misurare la fluorescenza dopo
l'ibridazione dell'acido nucleico di destinazione alle sonde
per microarray. E possibile utilizzare altri coloranti simili a
Cy-3 e Cy-5, come i coloranti Alexa 647, 555 e 660.

Gli scanner per microarray sono ottimizzati per un’alto
rendimento segnale-disturbo nelle bande di emissione Cy-3
(650—610 nm) e Cy-5 (650—750 nm), con un ampio intervallo
dinamico (fino a cinque ordini di grandezza) e cross-talk
spettrale basso. Questo consente di misurare un intervallo
molto ampio di concentrazioni di destinazione e garantisce
una maggiore sicurezza dei dati a livelli di segnale bassi.

L’eccitazione laser viene scansita rapidamente avanti e
indietro attraverso il microarray. Il gruppo dinamico/di
tracciamento con auto-focus garantisce che il microarray sia
sempre posizionato sul piano di messa a fuoco delle lenti di
scansione, per una maggiore uniformita di scansione.

Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.4) 17
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Introduzione

Rilevamento della fluorescenza

La fluorescenza dei campioni etichettati viene convertita in
un segnale elettrico da un PMT ad elevate prestazioni.
Amplificatori con un disturbo bassissimo e integratori
digitali elaborano il segnale PMT in un valore digitale che
viene registrato nel file TIFF.

Sottrazione dark offset

A livelli di segnale molto bassi, il disturbo puo causare valori di
pixel negativi. Invece di impostare tali valori su zero, portando
ad una misurazione errata, lo scanner Agilent aggiunge un
piccolo offset a tutti i valori di pixel, consentendo di riferire la
distribuzione completa dei pixel. Questo offset costante non e
disturbo, e viene rimosso in modo statisticamente corretto dal
software Agilent Feature Extraction.
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Questo capitolo descrive il funzionamento dello scanner e
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dei problemi al Capitolo 5.

Agilent Technologies 19



2 Operazioni preliminari

Licenza

Lo scanner Agilent puo essere ordinato in due
configurazioni:

la configurazione ad elevata risoluzione standard, o

la configurazione con la funzionalita ad elevata
risoluzione eliminata

Senza la licenza per elevata risoluzione, & possibile effettuare
la selezione a 10 micron, 5 micron e doppia passata a 5
micron, ma le selezioni a 2 e 3 micron non sono disponibili.

Se é stata acquistata la funzionalita ad elevata risoluzione, e
necessaria la licenza software per attivare questa funzionalita.
Nella maggioranza dei casi, il tecnico che installera lo scanner
installera anche la licenza. In caso contrario, o in caso la
funzionalita venga acquistata in seguito, seguire le istruzioni
riportate sotto per ricevere la licenza software.

Richiesta della licenza per scansione ad elevata risoluzione

Per richiedere la licenza per scansione ad elevata risoluzione:

1 Reperire il SEC (software entitlement certificate) fornito
con lo scanner.

2 Vistare il sito https://software.business.agilent.com/index.stm.

Selezionare Click here to start software license redemption
(Fare clic qui per richiedere la licenza software).

4 Seguire le istruzioni per ottenere la licenza.

Installazione della licenza per scansione ad elevata risoluzione

Una volta ricevuta la licenza per e-mail, installarla come segue:

1 Chiudere la finestra del software Scan Control.

2 Ubicare il file di licenza e posizionarlo nella seguente directory:
C:\ProgramFiles\Agilent\Microarray

3 Riavviare il software Scan Control.

Ora sono disponibili le selezioni a 2 e 3 micron.

20 Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.4)
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Operazioni preliminari 2

Licenza per codici a barre non Agilent

Se si ha la necessita di effettuare la scansione di codici a
barre non Agilent con risoluzione a 2 o 3 micron, contattare
Agilent per una licenza speciale gratuita per l'accesso a
questa funzionalita.

Senza questa licenza, se il codice a barre di un vetrino non
e presente o non viene riconosciuto dallo scanner come
array Agilent, e I'array deve essere scansito con risoluzione a
2 o 3 micron, lo scanner saltera il vetrino e verra
visualizzato il seguente messaggio:

“Scan settings or slide is not supported by the current scanner
license. Contact Agilent via pdl-non_ag_barcode@agilent.com to
obtain license to scan non-Agilent barcodes in high-resolution”

(Le impostazioni di scansione o per vetrini non sono supportate
dall'attuale licenza dello scanner. Contattare Agilent all'indirizzo
pdl-non_ag_barcode@agilent.com per richiedere la licenza che
consente di scansire i codici a barre non Agilent ad elevata risoluzione).

Richiesta ed installazione di una licenza per codici a barre non Agilent

1 Inviare una e-mail all'indirizzo
PDL-non_ag_barcode@agilent.com con il numero di serie dello
scanner indicato nel testo della mail per ricevere
prontamente una licenza. Questa licenza dovra essere
rinnovata ogni anno.

2 Una volta ricevuta la licenza, posizionarla nella seguente
directory:

C:\ProgramFiles\Agilent\Microarray
3 Chiudere e riavviare il software Scan Control.

Lo scanner riconoscera la nuova licenza.
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2 Operazioni preliminari

Messa in funzione dello Scanner

Operazione 1. Accensione dello scanner per microarray Agilent

Per istruzioni su come impostare
I'accensione e lo spegnimento
automatico dei laser, vedere
“Impostazione dell'ora per
accendere e spegnere i laser” a
pagina 63 nel capitolo 4.

4 Accendere lo scanner per microarray tramite 'interruttore
sul lato anteriore dello strumento. Si notera che:

a Si aziona una ventola e il coperchio si chiude.

b Lo scanner per microarray avvia una routine di
inizializzazione che dura circa quattro minuti. Durante
I'inizializzazione viene eseguito un auto-test; mentre
vengono effettuati i diversi controlli funzionali gli
indicatori luminosi di stato lampeggiano.

¢ I laser non si attiveranno fino a quando non viene
avviato il software Scan Control.

Indicatori /ﬂ

luminosi di
stato i .
e~ N ——— .
\ n° Oooo
et ST -n:o% é)o

Interruttore di
accensione — | ||~

Figura b Posizione dell’interruttore di accensione e degli indicatori
luminosi di stato

5 Fare doppio clic sull’icona Agilent Scan Control per
aprire il programma Scan Control.

Oppure
Selezionare Start > All Programs > Agilent > Scan Control.

Icona Agilent Scan Control

Quando viene avviato il programma, i laser cominciano la
fase di riscaldamento.
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6 Controllare il messaggio relativo allo stato dello scanner
sul bordo inferiore della finestra principale.

Lo scanner e in fase di inizializzazione. Quando
I'inizializzazione & ultimata, il coperchio dello scanner si
sblocca e i laser continuano il riscaldamento.

La fase di riscaldamento dei laser dura circa 30 minuti. In attesa
che i laser completino il riscaldamento, passare all’“Operazione
2. Inserimento dei vetrini nei portavetrini” a pagina 24.

Per attivare i laser, selezionare Tools > Laser Auto
ON/OFF Settings... e fare clic su Turn Lasers ON Now.

E possibile cominciare la scansione.

Per poter avviare il ciclo del caricatore circolare & necessario
che entrambi i laser abbiano ultimato il riscaldamento.

pilent Scan Control
File Tools Help
Stattsiat: [T »]  Endsiot [10 = Frafile: Operator:
Slot SidelD | Channels | Scan Region Resolution | TIFF | RPMT | GRMT | %DR Dutput Path Description
1| cAuodetects R+ Agilent HD (1% 21.6mm)  Gum 0Lt 100%  100%  <NoXDR»  Di\SeanData
2 | cAundetectr  R+G Agilent HD (1% 21.6mm)  Sum 20bt  100%  100%  <NoXDR:  D:ScanData
3 |Auodetects  ReG Agilent HD [E1#21 Bwm] 5 um 20bt  100%  100%  <NoXDR>  D:\ScarData
4 | cAuodetects R Agilent HD (E1 % 21 Bom)~ 5um 206t 100%  100%  <NoXDR>  D\ScanData
5 | cAuodetects R+ Agilent HD (1% 21.6mm]  Sum 0Lt 100%  100%  <NoXDR»  Di\SeanData
6 | cAuodetectr  F4G Agiert HD (61 4 21, 6mm] 5 um Wbt 100% 100%  MhXDRy  DiasewDan  [NND
7 | auodetects  ReG Agilent HD [1 %21 Bwm] 5 um 20bt  100%  100%  <No¥DR>  D:\ScarData
B |Auodetects  ReG Agilent HD (51 %21 Bwm) 20bt 100%  100%  <NoXDR>  D:\ScarData
9 | cAuodetects R+ Agilent HD (E1 % 21.6mm) Sum 0Lt 100%  100%  <NoXDR»  DiSeanData
10 | ¢hutodetects  Ref Agilent HD (1% 21.6mm)  Gum 0Lt 100%  100%  <NoXDR»  DiSearData
< | 2l
Scanner ready. e
Compress: [OFf] Split/Rotate: [OFF] Maming: USI1470FPBL_<Slide ID>_S<5can #3 Total file size: 3.0 GB Total run time: 1 hr 20 min

Figura7 Finestra principale Scan Control visualizzata quando i laser
sono pronti
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Operazione 2. Inserimento dei vetrini nei portavetrini

Le impronte digitali causano errori

nella rilevazione della fluorescenza.

Per una lettura precisa, usare
sempre | guanti quando si
maneggiano i vetrini, facendo
attenzione a toccare solo i bordi.

Evitare, inoltre, di scrivere con
pennarelli o di applicare etichette
sui vetrini, fatta eccezione per
I'apposito codice a barre.

Un vetrino deve essere inserito in un portavetrini prima di
essere caricato nel caricatore circolare. Il portavetrini
protegge il vetrino durante la scansione.

Figura 8 Caricamento dei vetrini nel portavetrini

1 Tenere il portavetrini per i lati con il logo Agilent rivolto
verso l'alto.

2 Appoggiare un pollice al centro della copertura del
portavetrini.

3 Esercitare una lieve pressione sulla copertura spingendo
verso l'estremita superiore del portavetrini, fino ad
avvertire lo scatto di sblocco.

Per istruzioni dettagliate su come rimuovere i vetrini, vedere
“Operazione 5. Rimozione dei vetrini” a pagina 33.
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Copertura del
portavetrini
shloccata

Figura 9 Shloccare la copertura

4 Posizionare il vetrino nel portavetrini in modo tale che I'estremita
del vetrino appoggi perfettamente sul supporto posteriore.

La superficie attiva del microarray deve essere rivolta
verso l'alto.

Superficie attiva del
microarray

Supporto per
portavetrini

Figura10 Posizionamento corretto del vetrino sul supporto
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5 Allineare il vetrino al portavetrini osservando le due
regole seguenti:

Posizionare sul supporto posteriore l’estremita del
vetrino priva dell’etichetta con il codice a barre.

La superficie del vetrino su cui & depositato il microarray
e rivolta verso la copertura. Il microarray viene scansito
attraverso il vetro.

Osservare sempre queste regole quando si esegue
I'allineamento dei vetrini.

I vetrini Agilent hanno due codici a barre, uno su ciascun
lato del vetro. Vedere Figura 11. In genere i vetrini non
Agilent hanno un solo codice a barre. Posizionare il
vetrino con il lato attivo, su cui & presente il microarray,
rivolto verso la copertura del portavetrini.

Vedere “Specifiche dei codici a Se l'array individuato si trova sul lato del vetrino opposto
barre e delle etichette con codice a a quello del codice a barre, 1o scanner non € in grado di
barre” a pagina 99 per le istruzioni leggere il codice a barre.

su come applicare un secondo
codice a barre leggibile.

Un vetrino inserito in modo scorretto pud danneggiare lo scanner per

microarray.
Double-barcoded slide example
i
g=
SIDE 1 £ = Inactive Glass Surface
Sm
|
i
>= Active Active
SIDE 2 ‘§= Microarray Microarray
E3 Surface Surface
|

Figura11 Lati del vetrino
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6 Lasciare l'altra estremita del vetrino facendolo scivolare
nel portavetrini.

I vetrino in posizione corretta e lievemente inclinato
contro le linguette laterali del portavetrini.

Linguetta

Figura12 Scivolamento del vetrino nel portavetrini

7 Per chiudere la copertura del portavetrini, premere
delicatamente con il pollice sulla copertura.

Figura13  Chiusura della copertura

8 Per bloccare la copertura, spingere indietro delicatamente la
copertura con il pollice fino a percepire lo scatto di blocco.
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Figura14 Blocco della copertura

9 Verificare che il coperchio del portavetrini sia
perfettamente chiuso.

Copertura bloccata
sotto le linguette
laterali

Figura1b Copertura bloccata correttamente
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Operazione 3. Caricamento dei portavetrini nel caricatore

circolare

Lo scanner per microarray esegue
la scansione dei vetrini nell’ordine
in cui questi vengono rilevati
durante la rotazione del caricatore
circolare, dagli slot con i numeri
inferiori a quelli con i numeri
superiori. Il ciclo del caricatore
salta gli slot vuoti.

Quando i vetrini sono correttamente inseriti nei portavetrini,
e possibile caricare i portavetrini nel caricatore circolare. Il
caricatore circolare ¢ concepito in modo da facilitare
I'inserimento corretto dei portavetrini. E possibile caricare i
portavetrini sia quando il caricatore si trova nello scanner o
quando e rimosso dallo scanner.

1 Caricare un portavetrini nello slot 1 del caricatore
circolare, il primo slot localizzato in senso orario a partire
dalla posizione iniziale.

Non posizionare vetrini nello slot di partenza del
caricatore circolare. Lo slot di partenza e piu grande degli
altri ed e contrassegnato dall’etichetta “Home”.

2 Accertarsi che il lato piu sottile del portavetrini sia
rivolto verso il centro del caricatore circolare.

3 Accertarsi che I'estremita inferiore del portavetrini sia a
contatto con il fondo dello slot del caricatore circolare.

Il lato piu
sottile é rivolto
verso il centro

Figura16  Caricatore circolare

Un posizionamento scorretto del portavetrini nel caricatore circolare
puo causare gravi danni allo scanner per microarray.

4 Se il caricatore circolare e gia installato, passare all'operazione 5.
In caso contrario installare il caricatore circolare.
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Se i portavetrini sono stati posizionati in un caricatore circolare
precedentemente rimosso dallo scanner per microarray, seguire
le operazioni seguenti per rimontare il caricatore.

a Montare il caricatore in modo che i fori di allineamento
del caricatore siano posizionati sopra i perni di
allineamento dello scanner per microarray nell’area
destinata ad accogliere il caricatore.

Allineare il foro a forma di D sul fondo del caricatore
con il supporto centrale a forma di D della parte
superiore dello scanner (dove va collocato il caricatore)
e posizionare delicatamente il caricatore nello scanner
in posizione verticale.

b Accertarsi che il caricatore sia correttamente posizionato.

Durante il montaggio del caricatore, evitare con cura di farlo urtare
conto il braccio di caricamento automatico. Questo, infatti, potrebbe
causare un disallineamento.

Se il caricatore deve essere ruotato manualmente, accertarsi prima
che lo scanner sia spento per evitare di danneggiare lo strumento.

5 (Opzionale) Coprire il caricatore circolare con l'apposita
copertura fino a percepire lo scatto di inserimento delle
due linguette laterali.

Linguette

Slot di partenza

Figura17  Copertura del caricatore circolare

6 Chiudere il coperchio dello scanner.
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N

Senza aver prima chiuso il coperchio, non & possibile
eseguire le seguenti operazioni:

Inizializzare lo scanner
Verificare la presenza di slot vuoti nel caricatore circolare

Leggere i codici a barre prima di avviare il caricatore
circolare

Avviare un ciclo del caricatore circolare

Perni di allineamento fissi Fori per perni di allineamento fissi

Perno di allineamento mobile Foro per perno di allineamento mobile

Figura18 Allineamento di perni e fori sullo scanner e sul caricatore

Se nel Carousel Log Report viene visualizzato un messaggio
d’errore che segnala un timeout del motore, il problema
potrebbe essere dovuto al montaggio scorretto del caricatore.
Verificare 1'allineamento del caricatore e ripetere il
montaggio, se necessario.
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Operazione 4. Scansione dei vetrini

Una scansione consiste nella  Effettuare i seguenti passaggi per preparare i vetrini per la

creazione di un'immagine delle sonde  scansione ed avviare il ciclo del caricatore circolare. Vedere

32

su un singolo vetrino. Unciclo del  1a sezione successiva, “Scansione dei vetrini”, per istruzioni
caricatore circolare consiste nella pitl dettagliate.

scansione di tutti i vetrini specificati
presenti nel caricatore.  “Operazione 1. Impostazione della posizione degli slot” a
pagina 36

“Operazione 2. Impostazione di un profilo per la modifica di
tutte le impostazioni nella tabella di scansione” a pagina 37

“Operazione 3. Modifica delle impostazioni di scansione nella
tabella di scansione” a pagina 38

“Operazione 4. Avvio del ciclo del caricatore circolare” a
pagina 39

“Operazione 5. Trasferimento dei file e archiviazione dei
dati” a pagina 42

Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.4)



Operazioni preliminari 2

Operazione 5. Rimozione dei vetrini

Quando il ciclo del caricatore circolare & completato, &
possibile rimuovere i portavetrini dal caricatore e quindi
rimuovere i vetrini dal portavetrini.

1 (Opzionale) Rimuovere il caricatore circolare dallo scanner.

Se il braccio di caricamento automatico dei portavetrini & esteso
nel caricatore, non rimuovere il caricatore. Seguire invece le
istruzioni contenute in “Risoluzione dei problemi del braccio di
caricamento automatico esteso nel caricatore” a pagina 82.

Rimuovere i portavetrini dal caricatore.
Rimuovere i vetrini dal portavetrini.

a Tenere il portavetrini per i lati con il logo Agilent
rivolto verso l'alto.

b Appoggiare un pollice al centro della copertura del
portavetrini.

¢ Esercitare una lieve pressione sulla copertura
spingendo verso l'estremita superiore del portavetrini,
fino ad avvertire lo scatto di sblocco.

Copertura del
portavetrini
sbhloccata
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d Spingere 'estremita del vetrino con il codice a barre da
sotto la copertura del vetrino, per evitare di lasciare
impronte sull’area del campione.

e Prendere il vetrino appoggiando le dita sui lati e
rimuoverlo dal portavetrini.

Spingere verso l'alto da sotto

Figura19 Rimozione corretta del vetrino
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Operazione 6. Impostazione dello spegnimento automatico
dei laser

E possibile prolungare la durata del laser impostando lo
spegnimento automatico dei laser in determinati orari.
Vedere “Impostazione dell'ora per accendere e spegnere i
laser” a pagina 63 al Capitolo 4, “Utilizzo degli strumenti”,
per ulteriori informazioni.

Non e necessario spegnere lo scanner per microarray.

Nel caso si desideri spegnere lo scanner, seguire queste istruzioni:
1 Fare clic su Exit nella finestra principale Scan Control.

Per evitare blocchi intermittenti della comunicazione,
chiudere il programma Scan Control prima di spegnere lo
scanner per microarray.

2 Attendere qualche secondo e verificare che il coperchio
dello scanner per microarray sia sbloccato.

3 Sollevare il coperchio.

Spegnere lo scanner per microarray con l'interruttore di
accensione situato sul lato anteriore.

Evitare qualsiasi tentativo di sollevare il coperchio prima di aver udito
lo scatto di shlocco Tentare di sollevare il coperchio durante la fase di
shlocco pud provocare I'inceppamento dello scanner per microarray
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Scansione dei vetrini

Operazione 1. Impostazione della posizione degli slot

Se si desidera eseguire la scansione dei vetrini in tutti i 48
slot, saltare all’“Operazione 2. Impostazione di un profilo per
la modifica di tutte le impostazioni nella tabella di
scansione” a pagina 37.

1 Nella casella Start slot, selezionare il numero dello slot in
cui si trova il primo vetrino che si desidera scansire.

2 Nella casella End slot, selezionare il numero dello slot in
cui si trova l'ultimo vetrino che si desidera scansire.

Start slot:: v End slot: |43 =

L’intervallo di slot inserito con le operazioni 1 e 2
condiziona la maggior parte delle funzioni della finestra
principale Scan Control.

¢ Nella tabella di scansione viene visualizzato solo
I'intervallo di slot inserito in questa fase.

* Lo scanner esegue solo la scansione dei vetrini
nell'intervallo di slot inserito in questa fase.

¢ Il comando Carousel Check esegue un controllo solo
sull'intervallo di slot inserito in questa fase per gli slot
vuoti e per i codici a barre supportati da Agilent. (Vedere
“Controllo per individuare i codici a barre supportati da
Agilent gli slot vuoti” a pagina 49 al Capitolo 3).
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Operazione 2. Impostazione di un profilo per la modifica di
tutte le impostazioni nella tabella di scansione

Un profilo & un insieme di impostazioni
di scansione e immagine che, se
selezionato, popola la tabella di
scansione con i valori immessi in
Profile Editor.

<predefinite>

AgilentHD_GX_2Color
AgilentHD_GX_1Color
AgilentHD_CGH
AgilentHD_miRNA
AgilentG3_CGH

¢ Dall'elenco dei profili, selezionare uno dei profili esistenti.

Profile:  |ERaEliE naEY

Quando si apre la finestra principale Scan Control, & possibile
vedere nelle colonne i valori delle impostazioni di scansione.
Questi valori sono stati impostati in base all'ultimo profilo
selezionato per un ciclo prima di chiudere il programma.

Agilent fornisce sei profili predefiniti per 1'uso con i
microarray ad alta densitd Agilent, i microarray Agilent G3 e
i microarray non Agilent.

Impostazioni predefinite visualizzate dopo l'installazione del
programma

Microarray di espressione genetica Agilent HD a 2 colore
Microarray di espressione genetica Agilent HD a 1 colore
Microarray Agilent HD CGH/CNV/ChIP

Microarray Agilent HD miRNA

Microarray Agilent G3 CGH/CNV/ChIP

Per modificare tutte le impostazioni contemporaneamente &
possibile selezionare uno dei profili Agilent o crearne uno
proprio da uno qualunque dei profili esistenti, incluso il
profilo <Default>.

Per modificare un profilo esistente o creare un proprio profilo,
vedere il capitolo 4, “Modifica di un profilo esistente” a
pagina 55 o “Creazione di un nuovo profilo” a pagina 56.
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Operazione 3. Modifica delle impostazioni di scansione nella
tabella di scansione

Se non & necessario modificare nessuna impostazione nella
tabella di scansione prodotta dal profilo selezionato,
attendere fino a quando il messaggio di stato dello scanner
indica che lo scanner & pronto e passare all'“Operazione 4.
Avvio del ciclo del caricatore circolare” a pagina 39.

1 Fare clic sulle celle che si desidera modificare.
Fare clic su una cella singola, o
Fare clic sull'intestazione di una colonna, o

Trascinare il cursore su celle multiple in una colonna
per selezionare celle contigue. Sulla destra della prima
cella selezionata verra visualizzata una freccia.

Premere Ctrl e selezionare celle non contigue all'interno
di una colonna, una per volta. Sulla destra dell'ultima
cella selezionata verra visualizzata una freccia.

2 Selezionare una nuova impostazione dall'elenco.

La nuova impostazione viene visualizzata in grassetto.

Scan Region f

Full Slide [71  21.6mm]
Agilent HD [61 = 21.6mm
A AU 6T 216

Una stima della dimensione totale del file e del tempo di esecuzione é riportata
nella riga di stato in fondo alla finestra principale Scan Control. E richiesto
spazio sull'unita C: per i file temporanei generati durante la scansione. Se la
dimensione stimata dell'immagine piti la dimensione del file temporaneo eccede
lo spazio disponibile, lo scanner non consentira I'avvio del ciclo del caricatore.

Agilent consiglia di selezionare un percorso di output per
I'archiviazione dei file di immagine su un'unita locale. Se si seleziona
un'unita di rete per il percorso di output, e la connessione di rete non
riesce, i file vengono salvati sull'unita C: locale nel file Program Files\
Agilent\Microarray\NetDataBackup.
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Operazione 4. Avvio del ciclo del caricatore circolare

Durante un ciclo del caricatore vengono scansiti tutti i
vetrini selezionati presenti nel caricatore.

1 Verificare che il messaggio relativo allo stato dello
scanner nella finestra principale visualizzi Scanner Ready.

Il ciclo del caricatore non puo essere avviato finché i
laser non hanno completato la fase di riscaldamento.

2 Fare clic su Scan Slot m-n nella finestra principale
Scan Control.

La lettera m rappresenta lo slot iniziale in cui &
posizionato il primo vetrino e la lettera n rappresenta lo
slot finale in cui e posizionato I'ultimo vetrino.

All’avvio della scansione si verifica quanto segue:
Il coperchio dello scanner si blocca;

Si apre la finestra di dialogo Scan Progress che
visualizza lo stato della scansione.

;
— Current scan information
File name: c\LPJAMT4B4 SLOTO_S07.tf
Barcode: 16011535021652
Slat numbir: 1
— Statu
Scanning... ;I
— Progress
Scan progress g
Carouzel progress 0% [0 of 1 glides completed)

Abort

Elose

Figura 20

finestra di dialogo Scan Progress

Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.4)
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Il Carousel Report Log presenta le
informazioni di scansione e i messaggi
di errore che si verificano durante il
ciclo di esecuzione del caricatore.

I messaggi nella casella Status della finestra di dialogo Scan
Progress informano l'utente sull’avanzamento di ciascuna
scansione e del ciclo del caricatore.

Quando il ciclo del caricatore € completato, la casella Status
visualizza il messaggio Carousel run completed.

Il log di report viene visualizzato automaticamente al
termine di un ciclo del caricatore.

AGILENT SCANNER -- CA{QOUSEL REPORT LOG

Scanmer SN: US1470PPB1

Fri Apr 11 11:01:38 2008

Carousel run requested from Slot 1 to Slot 29

Total number of slide(s) detected: 29.

Scanned image: D:'New Folder'US1470PPB1_123456782012 S01.tif

Scan completed.

Scanned image: D:'New Folder'US1470PPB1_251554817094 S01.tif

Scan completed.

Scanned image: D:'New Folder'US1470PPB1_251554819356_S01.tif

Scan completed.

Scanned image: D:'New Folder'US1470PPB1_251554819966_S01.tif

Scan completed.

Figura21 Carousel Report Log

Se si desidera aprire nuovamente il Carousel Report Log
finale dopo aver chiuso la finestra di dialogo Scan Progress,
e reperibile seguendo il percorso:

C:\Program Files\Agilent\Microarray\Logs\CarouselRunLog.htm

Il file viene sovrascritto ogni volta che si avvia un nuovo
ciclo del caricatore.

Una volta completato il ciclo, & possibile rimuovere i vetrini.
Vedere “Operazione 5. Rimozione dei vetrini” a pagina 33.
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Visualizzazione del Carousel Report Log durante il ciclo

E possibile visualizzare il Carousel Report Log in qualunque
momento durante il ciclo del caricatore.

e Fare clic su View Report nella finestra di dialogo Scan
Progress.

Controllo dei dati durante o dopo il ciclo

Consultare la Guida rapida de/ ¢ Una volta trasferiti tutti i dati relativi a una scansione,
software Feature Extraction, inclusa visualizzare il file nel software Agilent Feature Extraction
nei materiali forniti con lo scanner. 0 in un altro programma.

Se Feature Extraction 10.x ¢ stato installato su un altro disco fisso, &
necessario trasferire i file diimmagine su questa unita dopo il ciclo. Vedere
“Operazione 5. Trasferimento dei file e archiviazione dei dati” a pagina 42.

Annullamento di una scansione
In qualsiasi momento e possibile interrompere la scansione o
il ciclo del caricatore.

¢ Fare clic sul pulsante Abort nella finestra di dialogo Scan
Progress.

Viene visualizzato il seguente messaggio.

Carousel Run Abort x|

@ Do you wank to abort the carousel run now?

Click fes to abort the run now; you may lose scan data.
Click Mo to abort the run after the current scan is done.
Click Cancel to cancel your abort command.

Yes I Mo | Cancel |

Figura22 Messaggio relativo all’annullamento del ciclo del caricatore

Lo scanner per microarray impiega uno o due minuti per
portare a termine I'annullamento della scansione anche se &
stato selezionato Yes. Tutti i dati raccolti vengono salvati per
le analisi successive.
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Operazione b. Trasferimento dei file e archiviazione dei dati

¢ Al termine del ciclo, trasferire i file in un’altra cartella, se
necessario.
Sono disponibili quattro opzioni per il salvataggio dei file:

Nuova cartella nella cartella originale sull’unita locale
impostata per il percorso di output

Un’altra cartella sull’unita locale
Cartella in rete

E necessario trasferire i dati sul PC su cui & stato
installato il programma Feature Extraction.

CD o DVD

In ogni stazione di lavoro & incluso uno masterizzatore DVD.

E importante archiviare regolarmente i dati dal PC dello scanner per
assicurarsi che ci sia spazio su disco sufficiente per i cicli futuri.
Quando il disco & quasi pieno, lo scanner per microarray interrompe la
scansione e viene visualizzato un messaggio di attenzione.

E possibile migliorare le prestazioni deframmentando regolarmente
['unita disco.
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Puo accadere che, prima di effettuare la scansione di una
serie di vetrini, 'utente desideri modificare le impostazioni
di scansione o di immagine.

In questo capitolo viene descritta ciascuna impostazione della
tabella di scansione, poi vengono fornite informazioni su come
modificarle tutte contemporaneamente o una per volta.

° .
*e%e’
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Modifica delle impostazioni della tabella di scansione

E possibile modificare le impostazioni della tabella di
scansione in due modi:

Un profilo & un insieme di impostazioni e Modifica di tutte le impostazioni contemporaneamente

di scansione e immagine che, se mediante profili

selezionato, popola la tabella di e . e .. R .
. popora f . ¢ Modifica delle impostazioni individuali di scansione
scansione con i valori immessi in

Profile Editor. mediante menu a discesa nella tabella di scansione

Sebbene sia possibile modificare le voci nell'ordine che si
preferisce, per risparmiare tempo e possibile modificare le
voci in questo ordine:

a Se si effettua la scansione di vetrini non Agilent,
passare a “Creazione di una nuova regione di scansione
con Scan Region Editor.” perché piu pertinente per i
vetrini utilizzati rispetto a quelle presenti nella tabella
di scansione o nel Profile Editor.

b Se si effettua la scansione di vetrini Agilent o non
Agilent, passare a “Modifica delle impostazioni della
tabella di scansione mediante profili” selezionando un
profilo diverso.

¢ Dopo aver selezionato un profilo diverso (o modificato
o creato un nuovo profilo), passare a “Modifica delle
impostazioni individuali della tabella di scansione”.

Se si sceglie un profilo diverso dopo aver modificato
singole voci, le voci del profilo sovrascriveranno quelle
modificate singolarmente.

d Assicurarsi di inserire 1D dei vetrini manualmente o
automaticamente dopo aver selezionato un profilo. E
necessario effettuare questa operazione per i vetrini
senza codice a barre. E posstbile effettuare questa
operazione per i vetrini Agilent. Vedere “Slide ID” a
pagina 48.

Per informazioni su ciascuna delle impostazioni di scansione,
vedere “Impostazioni della tabella di scansione” a pagina 48.
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Modifica delle impostazioni della tabella di scansione
mediante profili

¢ Dal menu a discesa Profile, selezionare il profilo di cui si
desidera utilizzare le impostazioni durante il ciclo.

(=S| qilentHD_ G 2Cala

Figura23 Menu a discesa sulla finestra principale Scan Control

E possibile modificare le impostazioni per il profilo
selezionato (vedere “Modifica di un profilo esistente” a
pagina 55) oppure creare un nuovo profilo partendo da esso
(vedere “Creazione di un nuovo profilo” a pagina 56).

Quando si apre la finestra principale Scan Control, &
possibile vedere nelle colonne i valori delle impostazioni di
scansione. Questi valori sono stati impostati in base
all'ultimo profilo selezionato per un ciclo prima di chiudere
il programma.

Agilent fornisce sei profili predefiniti per 1'uso con i
microarray ad alta densita Agilent, i microarray Agilent G3 e
i microarray non Agilent.

AgilentHD_GX_2Color Microarray di espressione genetica Agilent HD a 2 colore
AgilentHD GX_1Color Microarray di espressione genetica Agilent HD a 1 colore
AgilentHD CGH Microarray Agilent HD CGH/CNV/ChIP
AgilentHD_miRNA  Microarray Agilent HD miRNA
AgilentG3_CGH Microarray Agilent G3 CGH/CNV/ChIP

Per i vetrini Agilent & possibile selezionare il profilo adatto
al tipo utilizzato di microarray Agilent.

Per i vetrini non Agilent ¢ necessario effettuare queste
modifiche alle singole impostazioni della tabella di scansione.
Oppure, € possibile creare un nuovo profilo da uno esistente.
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Modifica delle impostazioni individuali della tabella di scansione

Con questa tabella di scansione € possibile modificare le voci
per vetrini individuali oppure gruppi di vetrini selezionando
una voce dal menu a discesa di ciascuna colonna, eccetto
per le colonne Slide ID e Description.

1 Fare clic sulle celle che si desidera modificare.
Fare clic su una cella singola, o
Fare clic sull'intestazione di una colonna, o

Trascinare il cursore su celle multiple in una colonna
per selezionare celle contigue.

Sulla destra della prima cella selezionata verra
visualizzata una freccia.

Premere Ctrl e selezionare celle non contigue
all'interno di una colonna, una per volta.

Sulla destra dell'ultima cella selezionata verra
visualizzata una freccia.

2 Fare clic sulla freccia per visualizzare il menu a discesa e
selezionare l'impostazione.

Scan Region f

Agilent HD [B1 = 21.6mm) i el
Full Slide [71  21.6mm]
Agilent HD [61 = 21.6mm

A AU 6T 216

3

Figura24 Menu a discesa per le impostazioni delle regioni di scansione

Le impostazioni modificate vengono visualizzate in grassetto.

Vedere le descrizioni delle impostazioni di queste colonne in
“Impostazioni della tabella di scansione” a pagina 48.
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Ripristino delle impostazioni della tabella di scansione ai valori
correnti del profilo

I valori del profilo visualizzati dopo il ripristino sono i valori
originali del profilo selezionato.

1 Fare clic sulla cella o sulle celle di cui si intende
ripristinare le impostazioni.

Fare clic su una cella singola, o
Fare clic sull'intestazione di una colonna, o

Trascinare il cursore su celle multiple in una colonna
per selezionare celle contigue, oppure

Premere Ctrl e selezionare celle non contigue
all'interno di una colonna, una per volta, oppure

Fare clic sull'intestazione Slot nell’angolo superiore
sinistro della tabella per selezionare tutte le celle della
tabella di scansione.

2 Fare clic con il tasto destro del mouse sull'area
selezionata e scegliere Reset to Profile Value.

Reset to Profile Yalue

Fit Columnis) to Window
Best: Fit Column Sizes

Refresh Table

Figura25 Menu di scelta rapida per ripristinare i valori originali delle
impostazioni selezionate nel profilo corrente

Le impostazioni nel profilo corrente vengono visualizzate
nell'area selezionata.
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Impostazioni della tabella di scansione

Eile Tools Help

Start slot: |1 -

Slot Slide 1D

<Auto detects
| <Auto detects
| <Auto detect
<Auto detects
| <Auto detect
| {Auto detect
<Auto detect>
| <Auto detects

wom e mae w r| —

{Auto detect

o

<Auto detect>

Agilent Scan Control

End slat:

m - Profile:

Channels | Scan Region

fglent HD (61 % 21 6mm)
Agilent HD (61 = 21.6mm)]
Agilent HD [B1 = 21.6mm]
Agilent HD (61 x 21.6mm]
Agilent HD [E1 = 21.6mm]
Agilent HD [B1 = 21.6mm]
Agilent HD (61 » 21.6mm]
Agilent HD (61 x 21 Bmm]
Agilent HD [B1 » 21.6mm)]
Agilent HD [B1 = 21.6mm)]

Questa sezione descrive le impostazioni nella tabella di
scansione che possono essere modificate. La prossima
sezione fornisce informazioni su come modificarle.

AgilentHD_| o DOperator:
Fesolution | TIFF R PMT | GPMT | XDR Output Path Desciiption
5um 206 100%  100%  <NoXDR> DiScanDats
Sum 20bit  100% 1007 <MoxDRr  D:hScanData
Sum 20kt 100% 100% ¢MNoxDR>  DM\ScanData
Sum 20kt 100% 100%  <MoxDR>  DivScanData
Sum 20kt 100% 100% <Mo®DR>  D:\ScanDats
Sum wh 10 100 ex0Rr DiscarDae [
Sum 20kt 100% 100% ¢MNoxDR>  Di\ScanData
& urm 20kt 100% 100%  <MaxDR>  D:\ScanData
Bum 20kt 100% 100% ¢NoxDRy»  D:M\ScanData
Bum 20kt 100% 100% <MNoxDR>  [:\ScanData

Figura 26  Finestra principale Scan Control e tabella di scansione con impostazioni di profilo predefinite
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Slide ID

Identificatore del vetrino. Le voci Slide ID vengono utilizzate
come parte del nome del file di immagine se specificato
come parte del nome del file nel profilo corrente. Vedere
“Naming prefix 1 e Naming prefix 2” a pagina 56.

Inserimento automatico Se i vetrini dispongono di codici a
barre conformi alle specifiche contenute nelle “Specifiche dei
codici a barre e delle etichette con codice a barre” a pagina 99,
non € necessario inserire 1'ID del vetrino nella tabella di
scansione prima di avviare il ciclo del caricatore. La funzione
“Auto detect” nella colonna Slide ID significa che lo scanner
legge automaticamente i codici a barre supportati da Agilent
nella tabella di scansione alla scansione di ciascun vetrino.

E possibile inoltre inserire manualmente l'identificativo del vetrino.

Inserimento manuale E necessario inserire I'ID per i vetrini
senza codice a barre, oppure i vetrini con codici a barre di
formato non supportato, utilizzando la tastiera o un apposito
lettore di codice a a barre esterno.
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Se si inserisce l'identificativo mediante la tastiera, fare
doppio clic sulla cella Slide ID prima di digitare il codice a
barre o un identificativo di testo univoco.

Controllo per individuare i codici a barre supportati da Agilent gli slot
vuoti Per visualizzare i codici a barre supportati da Agilent e
individuare gli slot vuoti nella colonna Slide ID, fare clic su
Tools > Carousel Check.

Il programma prima controlla il caricatore circolare per
individuare gli slot vuoti e indica “No chip” in ciascuna
Slide ID senza vetrino. Quindi legge i codici a barre per
tutti i vetrini e li indica nelle celle Slide ID.

Dye channel  Definisce se vengono raccolte solo le informazioni del canale di
colorazione rosso (per esempio, colorazione Cy-5), solo quelle del
canale di colorazione verde (per esempio, colorazione Cy-3) o di
entrambi i canali. La selezione non ha alcun effetto sul tempo di
scansione, ma selezionando solo un canale di colorazione si
riducono le dimensioni del file fino a un fattore di 2.

Scanregion La regione di scansione definisce 'area del vetrino che deve
essere scansita. Deve essere sufficientemente grande da
acquisire I'intera area di stampa del microarray. Dev’essere
abbastanza piccola da evitare che la scansione si avvicini
troppo al codice a barre o ai bordi non trasparenti del vetrino,
compromettendo la capacita di autofocus dello scanner.
Riducendo al minimo la regione di scansione si riduce il tempo
di scansione e si risparmia spazio di archiviazione.

Agilent fornisce una regione di scansione adatta a tutti i vetrini
Agilent High Density e G3, e un'altra regione adatta alla scansione
di vetrini completi 1 x 3 senza etichetta con codice a barre.

Per i vetrino non Agilent, puod essere necessario utilizzare
una regione di scansione personalizzata piu adatta alla
regione stampata. Vedere “Creazione di una nuova regione di
scansione con Scan Region Editor.” a pagina 60.

Scan resolution Imposta la risoluzione di scansione (dimensione dei pixel) su
(um) 2,3, 5 0 10 micron.

Per le scansioni a 10 micron, ciascuna riga di pixel
nell'immagine TIFF rappresenta la media di due linee di
scansione, una acquisita in ciascuna direzione. Per le scansioni
a b, 3 e 2 micron, & possibile scegliere di ottenere questa
media con la scansione con doppia passata, oppure acquisire
una sola linea di scansione per ciascuna riga di immagine.
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Intervallo
dinamico
file TIFF

Imposta l'intervallo dinamico a 16 bit o 20 bit. Lo scanner
G2565CA ha esteso l'intervallo dinamico del PMT e
dell'elettronica di elaborazione del segnale. Selezionando
l'opzione di file TIFF a 20 bit, & possibile accedere a questo
intervallo esteso, per consentire la quantificazione delle
caratteristiche di segnale alto e basso in una sola scansione.

I1 software Scan Control consente ancora la tradizionale
scansione XDR a 16 bit, come descritto di seguito.

La tabella riportata qui sotto indica lo spazio di archiviazione e il
tempo di scansione per scansioni con passata singola e doppia per
ciascuna risoluzione selezionata ad un intervallo dinamico TIFF di
16 bit o di 20 bit. La regione di scansione & di 61 X 21,6 mm.

La barra di stato in fondo alla finestra principale Scan
Control indica una stima dello spazio di archiviazione e del
tempo di esecuzione necessari per completare l'intero ciclo
del caricatore di vetrini.

Tabella 1 Spazio di archiviazione e tempo di scansione per scansioni con
passata singola e doppia per la regione di scansione Agilent HD

61x21,6 mm
Risoluzione Spazio di Spazio di Tempo di
archiviazione, archiviazione,  scansione,
Mb, 16 bit Mb, 20 bit min.
Passata singola a 2 micron 1300 1600 20
Passata singola a 3 micron 620 760 15
Passata singola a 5 micron 200 300 8
Passata singola a 10 micron 52 115 8
Passata doppia a 2 micron 1300 1600 40
Passata doppia a 3 micron 620 760 30
Passata doppia a 5 micron 200 300 16

Le scansioni con doppia passata non richiedono uno spazio
di archiviazione maggiore rispetto alle scansioni con passata
singola, ma richiedono il doppio del tempo.
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Red PMT Gain Imposta il livello di sensibilita del PMT del canale rosso e
e del canale verde. Il PMT rileva la fluorescenza emessa dal
Green PMT Gain  microarray.

11 livello di output predefinito (100%) imposta il guadagno al
livello calibrato in fabbrica; si tratta dell'impostazione consigliata
per i microarray Agilent. E possibile ridurre indipendentemente
ciascuna impostazione dei canali di colorazione fino all’'1%.

Se un microarray € cosi luminoso da causare la saturazione
dell’estremita superiore del segnale di output, il livello di
sensibilita del PMT puo essere ridotto a un intervallo di
sensibilita che consenta la lettura di tutte le informazioni.

Rapporto XDR  Prima della disponibilita dell'intervallo dinamico per il file
TIFF a 20 bit, era necessario utilizzare la funzione eXtended
Dynamic Range sia sullo scanner che sul software Feature
Extraction per acquisire tutti i dati scansiti tra le funzionalita
con segnale molto basso e le funzionalita con segnale molto
elevato. Ora e possibile selezionare l'intervallo dinamico per il
file TIFF a 20 bit per acquisire l'ampia gamma dinamica di
dati come alternativa all'utilizzo della funzione XDR.

Con la funzione XDR attivata, lo scanner automaticamente
scansisce due volte lo stesso vetrino a due diversi livelli di
sensibilita PMT. Questo genera due immagini collegate che
Feature Extraction puo elaborare contemporaneamente per
produrre un singolo set unificato di dati di intensita estratti
che coprono fino a 6+ ordini di grandezza.

N

11 livello di sensibilitd elevato & impostato dal Red o Green
PMT Gain. La funzione XDR viene disattivata automaticamente
(una volta attivata) per valori inferiori a 10%.

L'impostazione della colonna del rapporto XDR comunica
allo scanner di eseguire una seconda scansione ad
impostazioni PMT inferiori. Ad esempio, se Red e Green PMT
sono impostati su 100%, e il rapporto XDR & impostato su
0,1, la seconda scansione verra effettuata con PMT impostati
su 10%. L'impostazione PMT piu bassa disponibile & 1%.

Output path Il pulsante Browse consente di selezionare una directory per
archiviare i dati di ciascuna scansione. Agilent consiglia di
acquisire i dati in una directory locale su un disco fisso
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secondario. E possibile selezionare anche una directory di
rete. Se si verifica un problema di accesso di rete durante la
scansione, i dati verranno salvati in una directory locale
temporanea e verra incluso un messaggio di avvertenza nel
report del ciclo del caricatore circolare.

Slide Descrizione di ciascun vetrino in fase di scansione. Queste
Description informazioni diventano parte delle informazioni sul file,
visualizzabili nel software Feature Extraction.
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Strumenti aggiuntivi 65

Se si desidera creare o modificare un profilo o una regione
di scansione o se si intende impostare l'ora di accensione e
spegnimento automatici dei laser, & necessario utilizzare gli
strumenti del menu Tools. Questo capitolo illustra l'uso di
questi tool:

Tools WEs
Profile Editor, ..
Scan Region Editar, ..
Laser duko ORJOFF Settings. ..

Log File Finder. ..

Figura27 Menu Tools
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Profile Editor

<Default>

AgilentHD_GX_
2Color

AgilentHD_GX_1Color
AgilentHD_CGH
AgilentHD_miRNA
AgilentG3_CGH

Scan Region
Editor

Lasers Auto
On/Off Settings

Con Profile Editor & possibile modificare le impostazioni per
ciascuno dei profili forniti con il software:

Il profilo le cui impostazioni vengono visualizzate all'installazione

Microarray di espressione genetica Agilent HD a 2 colore

Microarray di espressione genetica Agilent HD a 1 colore
Microarray Agilent HD CGH/CNV/ChIP

Microarray Agilent HD miRNA

Microarray Agilent G3 CGH/CNV/ChIP

Inoltre € possibile creare nuovi profili partendo da quelli esistenti.

Puo essere necessario effettuare la scansione di regioni di
microarray non installate come impostazione predefinita. Per
crearne di nuove, utilizzare Scan Region Editor.

Per prolungare la durata dei laser, € possibile impostare 1'ora
di accensione e spegnimento automatici dei laser in questa
finestra di dialogo.
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Creazione/modifica dei profili utilizzando Profile Editor

Modifica di un profilo esistente

Non e consentito rimuovere il
profilo <default> dall'elenco. E
possibile rimuovere tutti gli altri,
inclusi i profili creati a partire dal
profilo <default>.

E possibile modificare e salvare un profilo esistente. Oppure

¢ possibile modificare un profilo esistente e salvare le

modifiche con un nuovo nome per il profilo. (Vedere

“Creazione di un nuovo profilo” a pagina 56).

1 Selezionare Tools > Profile Editor dalla barra del menu
(Figura 27).

Profile Editor

Current Profile: =Dafaults= Import | Export |
El Ge
Description Default configuration settings =
= i
Dwve channel R+3 Save A, ..
Scan region Agilent HD (B1 % 21.6mm)
Scan resolution S um
Tiff file dynamic range 16 bit D
Red PMT gain 100%.
Green PMT gain 100%:
DR Ratio <Mo KDR=
=]
COutput path o
Slide description
Naming prefix 1 <Instrument Serial #=
Maring prefix 2 <Slok # >
Compress Tiff T
Splitfrotate image T
Figura28 Profile Editor

2 Selezionare un profilo da modificare.
3 Modificare le impostazioni di scansione e immagine

utilizzando le scelte descritte in “Modifica delle impostazioni
della tabella di scansione” a pagina 44 e “Impostazioni dei
profili non presenti nella tabella di scansione” a pagina 56.

4 Fare clic su Save.

Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.4) b5



4

56

Utilizzo degli strumenti

Creazione di un nuovo profilo

E possibile creare un nuovo profilo da un profilo esistente
salvando il profilo esistente con un nuovo nome.

1 Selezionare Tools > Profile Editor.
2 Selezionare un profilo esistente per salvarlo come nuovo.

3 Fare clic su Save As per salvare il file esistente con un
nuovo nome.

4 Inserire il nome, poi fare clic su Save.

b5 Modificare le impostazioni di scansione e immagine
utilizzando le scelte descritte in “Modifica delle
impostazioni della tabella di scansione” a pagina 44 e
“Impostazioni dei profili non presenti nella tabella di
scansione” a pagina 56.

6 Fare clic su Save.

Impostazioni dei profili non presenti nella tabella di scansione

Naming prefix 1
e
Naming prefix 2

Le seguenti impostazioni non sono visualizzate nella tabella
di scansione. Questi parametri sono applicabili a tutte le
scansioni nel ciclo del caricatore circolare.

Per le scansioni standard, il programma Scan Control utilizza

tre segmenti di nome per comporre il nome del file.
Prefix1_Prefix2_ScanNumber.tif.

Per le scansiont XDR, un segmento aggiuntivo (_H o _L) viene

aggiunto al nome file per distinguere 'immagine XDR Hi
dall’'immagine XDR Lo:

Prefixl_Prefix2_ScanNumber_H.tif
Prefixl_Prefix2_ScanNumber_L.tif

Il Prefixl predefinito & Instrument Serial #, ma & possibile
selezionare Slide ID o il proprio prefisso personalizzato.

Il Prefix2 predefinito € SlideID, ma & possibile selezionare
Slot #, Scan Date Time oi il proprio prefisso personalizzato.
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= Image File Settings

Qutput path [
Slide description
Marning prefix 1 <Instrument Serial # =
<Customize: =
Customize <Slide D=
Compress Tiff «<Scan DateTime >
Splitfrotate image <Slat #=

Slide ID - Se selezionata, la voce nella cella Slide ID
compare nel nome del file. Se <Auto detect> si trova nella
cella Slide ID, il codice a barre comparira nel nome file.

Slot# — II numero dello slot in cui si trova il vetrino scansito.

Scan DateTime - Se si seleziona questa opzione, verranno
utilizzate la data e 'ora in formato AAAAMMGGOOMM.

Customize - Se si seleziona Customize, inserire un
prefisso personalizzato (massimo 36 caratteri).
Il programma Scan Control assegna automaticamente lo Scan
Number.

Il programma confronta il nome file di una nuova
scansione con quelli nella directory di dati selezionata.

Se Prefix1_Prefix2 & univoco, il numero di scansione viene
impostato su SO1.

Se si trova una corrispondenza, il numero di scansione
viene aumentato fino ad ottenere un nome file unico.

Esempio

US4510PP02_251485023883_S03.tif

e Instrument Serial # = US4510PP02

e Slide ID = 251485023883

* ScanNumber = S03. Si tratta del terzo file di scansione

nella directory con lo stesso Instrument Serial # e Slide ID.

Compress TIFF  E possibile ridurre la quantita finale di spazio di archiviazione
occupato dalle immagini di scansione comprimendo i file TIFF.

L’algoritmo di compressione utilizzato, LZW, riduce lo spazio
di archiviazione del 20 - 70%.
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Split/rotate
image

Alcuni programmi di analisi utilizzano dati ottenuti da immagini
ad una sola colorazione e ruotate di 90 gradi. Se si imposta
I'opzione Split/Rotate su Yes, il file colore viene diviso in due
file colore e le immagini vengono ruotate di 90 gradi e capovolte.

Si veda qui di seguito un esempio dell’immagine:

ees | —>

YBCD

Ai file divisi vengono attribuiti i nomi FileName_green e
FileName_red, dove FileName ¢ il nome assegnato
automaticamente al file prima della divisione.

Se e stato selezionato un solo canale di colorazione per il
file di output, € necessario selezionare comunque questa
casella per ruotare 'immagine, anche se non c’é¢ la necessita
di dividere il file.

Questa opzione é disponibile solo per le scansioni con
intervallo dinamico TIFF a 16 bit.
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Creazione/modifica di regioni di scansione utilizzando Scan
Region Editor

La regione di scansione definisce 'areadel ~ Quando si utilizzano vetrini non Agilent, € possibile creare la
vetrino che deve essere scansita. Piula  propria regione di scansione o modificare una regione
regione e grande, maggiore sara il tempo  esjstente fino alle dimensioni massime di 71 mm x 21,6 mm.
di scansione. Le regioni di scansione .3 nyova regione viene visualizzata come selezione nella

possono variare a causa di fattori qualiil - ¢he11a di scansione e nel Profile Editor.
posizionamento e le dimensioni

dell'etichetta del codice a barre o la
presenza di aree di vetro smerigliato.

Avwvio di Scan Region Editor

Dalla finestra principale Scan Control

¢ Selezionare Tools > Scan Region Editor dalla barra del
menu (Figura 27).

W Agilent Technologies - Scan Region Editor ) o o 3
File Help
O|&|X| 7
Scanner G2505C
T - WIDTH

‘ Scan Region
[3.10.1.50]
Min upper left comer

G
i M lawer right comer
i [74.20, 2350

Slide

Slide Holder /

Name # Pos [mm] | Pos (mm) | 'Width [mm] | Height [mm] | =
(61 ] 11.00 1.0
Fastiiddle 11.00 1090 £1.00 200

Fast71mm 30 1.90 .00 200
PGWTest! .00 1.90 61.00 200
PGWTest2 11.00 1.90 61.00 2.00 =

Figura29 Scan Region Editor
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Dal menu Start

* Selezionare Start > Programs > Agilent Life Sciences >

Scan Region Editor dalla barra delle applicazioni.

Non ¢ possibile accedere alla voce di menu Scan Region
Editor nella finestra principale quando lo scanner é in
funzione. Tramite il menu Start & possibile solo creare e
modificare nuove regioni di scansione.

Creazione di una nuova regione di scansione con Scan
Region Editor.

Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.4)

Quando si crea una nuova regione di scansione o si
utilizzano regioni di scansione esistenti, accertarsi che la

regione di scansione si trovi a una distanza di almeno 4 mm

dall’etichetta del codice a barre e non si sovrapponga ad
altre aree opache o traslucide del vetrino.

1 Selezionare File > New Region dalla barra del menu
all'interno di Scan Region Editor.

. Add New Region M= 3
MName: ||
Ranges{mm):
* mm 310 - 69.10
N mm 190 - 2340
Width: mm 500 - 71.00
Height: rmm 010 - 21.60
Save I Exit |

Figura30 Finestra di dialogo Add New Region

2 Inserire il nome o le dimensioni della regione.

3 Inserire le misure in mm relative alla regione, utilizzando

1 criteri elencati sotto.
I valori non validi verranno contrassegnati in rosso.

Misura dell’asse X per I'angolo superiore sinistro. Inserire
questa misura e quella dell’asse Y in mm per posizionare

la regione sul vetrino.



Width

Height

Ranges

Show Custom
regions only

Utilizzo degli strumenti 4

Misura dell’asse Y per I'angolo superiore sinistro.

Larghezza della regione di scansione misurata
dall’estremita dell’asse X nell’angolo superiore sinistro.

Altezza della regione di scansione misurata dall’estremita
dell’asse Y nell’angolo superiore sinistro.

Intervallo di valori che possono essere inseriti per ogni
misura.
Fare clic su Save.

Se non vengono rilevati errori, viene visualizzato Scan Region
Editor con I'elenco contenente la nuova regione di scansione.

% Pos [mm] | “Width [mm] | Height [mm]
Custom Region 1 |218 [195 | 70an |21.50

Figura31 Elenco delle regioni di scansione

Quando questa casella e selezionata, nell’elenco di Scan
Region Editor vengono visualizzate solo le regioni di
scansione personalizzate. Se la casella & deselezionata, &
possibile visualizzare nell’elenco anche le regioni fornite
da Agilent. Queste regioni, tuttavia, non possono essere
modificate con Scan Region Editor.

Chiudere Scan Region Editor.

Le nuove regioni create vengono ora visualizzate negli
elenchi delle regioni di scansione, sia nella tabella di
scansione che nel Profile Editor.

Modifica di una regione di scansione esistente per vetrini

non Agilent

E possibile modificare solo le regioni di scansione create
dall'utente. Non ¢ possibile modificare o rimuovere le regioni
fornite da Agilent.
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Quando si crea una nuova regione di scansione o si
utilizzano regioni di scansione esistenti, accertarsi che la
regione di scansione si trovi a una distanza di almeno 4 mm
dall’etichetta del codice a barre.

1 In Scan Region Editor, selezionare la regione da modificare.
2 Selezionare File > Open Region dalla barra del menu.

Viene visualizzata la finestra di dialogo Modify Region.

w. Modify Region M= E3
Name: I
Ranges(mrm):
. [400 Tmm 310 -gat0
Wi 2.00 mm - 1.90 - 2340
oo

“idth: |6 mm 500 - 7010
Height: |1.00 mm 010 - 2150

Save Exit |

Figura 32 Finestra di dialogo Modify Region

3 Modificare il nome o le dimensioni della regione.

Modificare le misure relative alla regione, utilizzando i
criteri elencati in “Creazione di una nuova regione di
scansione con Scan Region Editor.” a pagina 60.

5 Fare clic su Save.
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Impostazione dell'ora per accendere e spegnere i laser

Utilizzo degli strumenti

1

Per estendere la durata dei laser dello scanner, & possibile impostare

il programma Scan Control per l'accensione o lo spegnimento
automatici dei laser. Questa caratteristica consente di impostare
I’'avvio del riscaldamento dei laser e della preparazione della
scansione all'orario specificato oppure lo spegnimento automatico

dei laser a un determinato orario o quando sono inattivi.

Indipendentemente dalle impostazioni Laser Auto ON/OFF:

¢ E possibile accendere o spegnere i laser manualmente in

qualsiasi momento.

e I laser si accendono all’avvio del programma Scan Control.

¢ [ laser rimarranno accesi se all’'orario specificato per lo
spegnimento automatico, lo scanner sta effettuando una scansione.

Impostazione dell'accensione o dello spegnimento

automatico dei laser

1 Selezionare Tools > Laser Auto ON/OFF Settings dalla

barra del menu (Figura 27).

2 Fare doppio clic su No per impostare Enable laser auto

ON/OFF su Yes.

Laser Auto ON/OFF Settings

[l
Enable laser auto OMNJOFF
=]
B Turn OM daily
Turn M at

El

& Turn OFF daily
Turn CFF at

B Turn OFF when idle
Idle far{hr)

es

Every day
7:00 &M

es
§:00 PM
es

1

Turn Lasers on Mow |

Ok

Cancel |

Figura 33  Pagina delle proprieta Laser Auto ON/OFF Settings
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Se si seleziona NO, i laser devono essere accesi e spenti manualmente,
come descritto nella sezione seguente.

Turn ON daily Selezionare Weekdays only o Weekends, e specificare
l'orario di accensione dei laser durante la settimana o nei
fine settimana.

Turn OFF daily Selezionare Yes e specificare l'orario di spegnimento dei
laser durante la settimana o nei fine settimana.

Turn OFF when idle Selezionare Yes e specificare un intervallo di tempo di
inattivita dello scanner oltre il quale lo scanner spegnera i
laser. Se si seleziona No, lo scanner non si spegnera in
presenza di questa condizione.

3 Fare clic su OK.

Spegnimento o accensione manuale dei laser

1 Aprire la pagina delle proprieta Laser Auto ON/OFF
Settings.

2 Fare clic su Turn Lasers on Now o Turn Lasers off Now.
3 Fare clic su OK.
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Strumenti aggiuntivi

I seguenti strumenti aggiuntivi sono disponibili nel menu Tools.

Unlock Door

Lo strumento per l'apertura dello sportello (Tools > Unlock
Door) puo essere utilizzato per sbloccare manualmente lo
sportello nel caso in cui il blocco dello sportello non funzioni
correttamente. Questo puo accadere, ad esempio, se il
coperchio viene sollevato mentre il blocco funziona
automaticamente alla fine di un ciclo del caricatore circolare.

Reset Calibration Warnings

Durante il normale funzionamento, lo scanner G2505C calibra i
valori di PMT prima di ogni scansione, e calibra i laser durante
l'inizializzazione del sistema e dopo ogni ciclo del caricatore
circolare. Se la calibrazione non avviene correttamente, o se la
calibrazione differisce significativamente dalla calibrazione
precedente, il software dello scanner registra questo fatto e
genera un messaggio di avvertenza nel Carousel Run Log.

L'avvertenza relativa alla calibrazione del valore PMT viene
impostata quando il voltaggio PMT cambia di oltre il 20%
rispetto al valore della precedente calibrazione.

I messaggi di avvertenza relativi alla calibrazione del laser
vengono impostati quando i laser non riescono a raggiungere
la potenza specificata durante il periodo di riscaldamento. In
questo caso, il sistema imposta il messaggio di avvertenza e
ricalibra i laser all'80% della loro potenza specificata. Il
programma Scan Control scala il file TIFF per compensare la
potenza inferiore dei laser.

E possibile reimpostare questi messaggi di avvertenza
selezionando Tools > Reset Calibration Warnings.

Se anche la calibrazione successiva non va a buon fine e vengono
nuovamente visualizzati i messaggi di avvertenza, € necessario
contattare il centro vendita e assistenza Agilent locale.
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Extended Laser Calibration

La normale calibrazione dei laser non misura l'output di
potenza massima. Il tool per la calibrazione estesa del laser
effettua un controllo pitt approfondito del sottosistema dei
laser. Se vengono visualizzati ripetuti messaggi di avvertenza
relativi alla calibrazione del laser, l'assistenza Agilent puo
richiedere l'utilizzo del tool di calibrazione estesa del laser e
l'invio di una e-mail contenente i file di log con i risultati.
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la risoluzione dei problemi dello scanner per microarray
Agilent G2565CA.
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5 Manutenzione e risoluzione dei problemi del sistema

Manutenzione del sistema

Operazioni di
manutenzione
programmate

Consigli per
evitare
problemi

La dovuta attenzione e la corretta manutenzione assicurano
un funzionamento dello scanner per microarray senza
problemi. In caso di dubbi sull’impiego o la manutenzione
dello scanner per microarray, consultare il centro vendita e
assistenza Agilent locale.

Questa sezione descrive le operazioni di manutenzione del
software e dell’hardware che devono essere eseguite su base
regolare per garantire un funzionamento efficiente dello
scanner per microarray.

Questa sezione fornisce alcuni consigli sull’impiego e la
manutenzione dello scanner per microarray, che possono
risultare utili per evitare problemi.

Manutenzione programmata del software

Eseguire le seguenti operazioni per mantenere inalterate le
prestazioni della stazione di lavoro e del sistema operativo
MS Windows:

¢ Almeno una volta alla settimana, controllare lo spazio su
disco e archiviare i dati secondo la necessita.

¢ Una volta alla settimana eliminare i file temporanei (file
*.mp, *.tmp) dalla cartella c:\Temp.

¢ Se si nota un rallentamento del sistema, deframmentare il
disco fisso utilizzando il software di deframmentazione.
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Manutenzione programmata dell’hardware

Eseguire le seguenti operazioni per mantenere inalterate le
prestazioni dello scanner per microarray.

Controllo delle bocchette e del filtro dell’aria

Un buon flusso di aria attraverso lo scanner per microarray
e¢ fondamentale per un funzionamento corretto. Bocchette
ostruite e filtri dell’aria sporchi possono pregiudicare il
corretto funzionamento dello scanner.

Bocchette Verificare tutte le bocchette settimanalmente per
accertarsi che non siano ostruite da polvere e frammenti
oppure ostacolate da mobili o altri strumenti.

Filtro dell'aria La pulizia del filtro dell’aria dello scanner per
microarray deve essere verificata una volta al mese tramite
la procedura seguente:

1 Spegnere lo scanner per microarray.

2 Aprire e rimuovere lo sportello di accesso al filtro dell’aria,
situato sul lato destro dello scanner per microarray.

Sportello
>\._— rimovibile per

N1/ I'accesso al

filtro dell’aria

Figura 34  Apertura e rimozione dello sportello di accesso al filtro dell’aria

3 Rimuovere il filtro dell’aria dall’alloggiamento ed
effettuare un controllo visivo.
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Sportello d’accesso al
filtro dell’aria

Filtro
dell’aria

Figura3b Rimozione del filtro dell’aria

Pulizia del filtro dell’aria

In caso di accumulo di eccessiva sporcizia o se il filtro dell’aria
non viene pulito da oltre sei mesi, procedere alla pulizia.

1 Lavare il filtro dell’aria in acqua calda.
2 Strizzare accuratamente il filtro dell’acqua.
Tutta I'acqua in eccesso deve fuoriuscire dal filtro dell’aria.

3 Lasciar asciugare completamente il filtro dell’aria prima di
reinstallarlo. E possibile utilizzare salviettine di carta per
assorbire I'acqua in eccesso.

4 Reinstallare il filtro dell’aria nel relativo alloggiamento e
richiudere lo sportello.

Verificare che il filtro dell’aria sia stato reinstallato una
volta asciutto. La mancata reinstallazione del filtro
dell’aria puo causare 'accumulo di polvere all’interno
dello strumento e questo potrebbe pregiudicare il corretto
funzionamento dello scanner.

I filtri dell’aria (p/n 3150-0956) possono essere ordinati
direttamente presso il centro vendita e assistenza Agilent
locale.
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Consigli per evitare problemi

Eseguire le operazioni di manutenzione programmate descritte
alle pagine precedenti e seguire questi consigli per mantenere
inalterate le prestazioni dello scanner per microarray.

Consigli per evitare la perdita dei dati

e Evitare di caricare programmi che implicano un carico di
lavoro eccessivo della CPU, perché questo potrebbe
compromettere 1'acquisizione dei dati durante la scansione.

Consigli per evitare danni ambientali allo scanner

* Tenere lo scanner per microarray lontano da liquidi e vapori.

¢ Ridurre al minimo e tenere sotto controllo le fluttuazioni
di temperatura.

Evitare di esporre lo scanner per microarray alla luce diretta
del sole. Evitare di posizionare lo scanner per microarray in
prossimita di finestre, per quanto dotate di tapparelle o
tende. Il calore del sole puo scaldare 'alloggiamento dello
scanner per microarray in modo non uniforme, causando
problemi all’allineamento del sistema ottico.

Eseguire la scansione solo quando la temperatura del
laboratorio € compatibile con le specifiche sulla
temperatura di funzionamento dello scanner per
microarray. Per garantire ottime prestazioni dello scanner
per microarray, azionare lo scanner rispettando gli
intervalli di temperatura specificati. (Vedere “Specifiche
dello scanner per microarray” a pagina 96.)

¢ Controllare I'umidita.

Lo scanner per microarray € potenzialmente sensibile alle
condizioni di umidita con generazione di condensa. Per
garantire ottime prestazioni dello scanner per microarray,
azionare lo scanner rispettando gli intervalli di umidita
specificati. (Vedere “Specifiche dello scanner per
microarray” a pagina 96.) Consentire sempre 10 ore di
equilibrazione termica prima di togliere lo scanner
dall’imballo dopo la consegna.
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Consigli per mantenere inalterate le prestazioni dell’hardware

Evitare di spostare lo scanner per microarray.

Lo spostamento dello scanner per microarray puo causare
una compromissione delle prestazioni. Contattare il centro
vendita e assistenza Agilent locale per le istruzioni su
come spostare lo scanner per microarray.

Posizionare lo scanner per microarray su un tavolo di
laboratorio o su un piano robusto.

Evitare di appoggiarsi allo scanner per microarray.

Per estendere la durata dei laser, impostare 1'accensione e
lo spegnimento automatico dei laser. Vedere “Impostazione
dell'ora per accendere e spegnere i laser” a pagina 63 al
Capitolo 4.

Dopo l'accensione, prevedere il tempo necessario allo
strumento per il riscaldamento e la stabilizzazione. Il
tempo massimo di riscaldamento € di 30 minuti.

Mantenere pulito il pavimento del caricatore utilizzando
un panno ed evitando l'impiego di solventi.

Evitare I'uso di acetone o di altri solventi per la pulizia.

Evitare di toccare gli ingranaggi nell’area del caricatore.

AVVERTENZA Evitare di rimuovere le coperture. Non tentare di riparare o accedere

ai componenti interni. Esiste il rischio di esporsi ad alta tensione e a
radiazioni laser pericolose.
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Risoluzione dei problemi del sistema

Assistenza tecnica

Domande
frequenti

Risoluzione dei
problemi legati
all’hardware

Risoluzione dei
problemi legati
al software

Messaggi di
errore dello
scanner

Lo scanner per microarray Agilent & stato concepito per
richiedere una manutenzione ridotta ed essere intuitivo.
Qualora non si riesca a risolvere un problema riguardante il
sistema, leggere questo capitolo di prima chiamare il centro
vendite e assistenza di Agilent.

Questa sezione fornisce informazioni importanti
sull'assistenza tecnica.

Questa sezione contiene soluzioni alle domande frequenti
correlate all'assistenza e alla manutenzione.

Questa sezione descrive gli indicatori luminosi e spiega come
sostituire i fusibili.

Questa sezione illustra le precauzioni che occorre adottare
quando si utilizza il Recovery CD per recuperare il software
e i dati sul disco fisso.

Leggere questa sezione per informazioni sui principali
messaggi di errore e le relative soluzioni.

Guida all'uso dello Scanner per microarray Agilent G2565CA (software Scan Control 8.4) 73



5

74

Manutenzione e risoluzione dei problemi del sistema

Assistenza tecnica

Per lo scanner per microarray Agilent € previsto un servizio
di assistenza tecnica. Si raccomanda di leggere il resto del
capitolo prima di chiamare il centro vendite e assistenza
Agilent locale.

Utilizzare Internet per contattare I'assistenza tecnica

Il software viene consegnato con URL predefinito che
consente il collegamento all’assistenza tecnica Agilent per lo
scanner per microarray.

e Fare clic su Help > Technical Support.

Assistenza per la stazione di lavoro

In caso di problemi con la stazione di lavoro, leggere la
documentazione fornita insieme al PC.

Se il problema persiste, contattare il centro vendite e
assistenza Agilent locale oppure fare clic su Help >
Technical Support.

Assistenza per gli scanner per microarray

Qualora un problema riguardante lo scanner per microarray
richieda l'assistenza del centro vendite e assistenza Agilent
locale, € possibile che venga chiesto di fornire gli ultimi file di
log diagnostici creati dal programma Scan Control. Questi file
si trovano nella cartella C:\Programmi\Agilent\Microarray\Logs.

Si puo risalire ad altre informazioni di diagnostica, compresi
i risultati dell’autotest di accensione (Power-on Self Test),
utilizzando il programma HyperTerminal. Per maggiori
informazioni su come configurare e utilizzare questo
protocollo di comunicazione, vedere “Utilizzo di
HyperTerminal per acquisire dati diagnostici” a pagina 83.

Ogni scanner per microarray Agilent e identificato da un
numero di serie univoco di 10 caratteri. Il numero di serie si
trova su un’etichetta in due punti sullo scanner per
microarray: una nello scomparto del caricatore circolare e
una dietro la porta del filtro.
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Nella corrispondenza indirizzata al centro vendite e

assistenza Agilent locale relativamente allo scanner per
microarray, non dimenticare di includere il numero del
modello e il numero di serie costituito da 10 caratteri.

Prendere nota del numero di serie del proprio scanner per
microarray Agilent, annotare il numero di versione del
software e la data di installazione negli spazi sottostanti (se
si stampa questa pagina) oppure trascriverli su un foglio di
carta da conservare vicino allo scanner.

Informazioni sullo scanner

N. modello:

N. di serie:

Data di
installazione:

Versione software:

N. versione/ data di aggiornamento software:

N. versione/ data di aggiornamento software:

Ricerca delle informazioni sulla versione per il software dello scanner

1 Selezionare Help > About dalla barra del menu per
trovare le informazioni sulla versione.

2 Per chiudere il programma, fare clic su OK.
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Domande frequenti (FAQ)

Tabella2 FAQ

Quelle che seguono sono le domande frequenti (FAQ) con le
relative risposte, utili per utilizzare e mantenere lo scanner
per microarray Agilent nonché per risolvere gli eventuali
problemi che potrebbero insorgere.

FAQ

Risposta

Desidero spostare lo scanner per
microarray in un‘altra area.

Posso salvare i file sulla rete durante la
scansione?

Dove é possibile reperire informazioni di
supporto come driver, guide e soluzioni ai
problemi per la propria stazione di lavoro?

Non riesco ad aprire il coperchio per
accedere al caricatore circolare.

Il programma Scan Control non risponde.

Gli spostamenti possono compromettere le prestazioni dello scanner. Rivolgersi al
centro vendite e assistenza Agilent locale per ottenere aiuto nello spostamento
dello scanner e assicurarsi un funzionamento corretto a spostamento avvenuto.

Durante la scansione, Agilent consiglia di salvare i file di dati direttamente sul
disco fisso locale. | file di dati possono essere salvati anche in una directory in
rete. Se si verifica un problema di accesso di rete durante la scansione, i dati
verranno salvati in una directory locale temporanea e verra incluso un
messaggio di avvertenza nel report del ciclo del caricatore circolare.

In caso di problemi con la stazione di lavoro, leggere la documentazione fornita
insieme al PC. Se il problema persiste, contattare il centro vendite e assistenza
Agilent locale.

Non forzare il coperchio, altrimenti si rischia di danneggiare lo scanner per
microarray.

1 Premere verso il basso per ridurre una eventuale tensione di spinta e quindi
provare ad aprire il coperchio. In caso di mancato successo, passare al punto 2.

2 Chiudere e quindi riavviare il programma Scan Control.

3 Provare ad aprire il coperchio.

4 Seil coperchio non si apre, chiudere il programma Scan Control e spegnere lo
scanner per microarray, quindi riaccenderlo.

5 Provare ad aprire il coperchio.

6 Se il coperchio non si apre, contattare il centro vendite e assistenza Agilent
locale.

Il programma Scan Control ha cessato di rispondere—non vi sono state
variazioni nel messaggio di stato per oltre 15 minuti e non si riesce a chiudere il
programma. Eseguire quanto segue:

1 Aprire Windows Task Manager (Ctrl-Alt-Canc) e chiudere il programma Scan
Control. Quindi riavviare il programma Scan Control.

2 Seil passo precedente fallisce, riavviare la stazione di lavoro, spegnere lo
scanner per microarray e quindi riaccenderlo, attendere che I'indicatore di
stato si spegna e quindi riavviare il programma Scan Control.
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5

FAQ Risposta
Cosa faccio se un vetrino viene inserito 1 Spingere o tirare con delicatezza il braccio di caricamento automatico, a
solo per meta nel caricatore circolare dal procedendo nella direzione che oppone meno resistenza, fino al termine del
braccio di caricamento automatico? raggio di movimento. Non forzare.

2 Chiudere e quindi riavviare il programma Scan Control.

3 Seil problema persiste, chiamare il centro vendite e assistenza Agilent locale.
Lo scanner per microarray € acceso, ma 1 Verificare che la stazione di lavoro sia accesa.
la luce gialla non si spegne dopo 20 2 Verificare che il cavo USB sia collegato dalla stazione di lavoro allo scanner
minuti. per microarray.

3 Contattare il centro vendite e assistenza Agilent locale.
Lo scanner per microarray scanner & 1 Chiudere e quindi riavviare il programma Scan Control.

acceso e il programma Scan Control &
aperto, ma lo scanner non awvia la
scansione.

Lo scanner per microarray deve essere acceso prima di avviare il programma
Scan Control. Se il programma Scan Control é stato avviato prima, la
connessione non avviene quando si accende lo scanner.

Contattare il centro vendite e assistenza Agilent locale.
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Risoluzione dei problemi legati all"hardware

Lo scanner per microarray include pochissimi componenti
che possono essere sottoposti a manutenzione direttamente
dall’'utente. L’utente puo adottare misure in base agli errori
segnalati dagli indicatori luminosi di stato sul lato anteriore.
Inoltre puo sostituire i fusibili che proteggono il sistema.
Qualsiasi altro problema, compresi gli inceppamenti, deve
essere risolto contattando il centro vendite e assistenza
Agilent locale.

In caso di problemi con la stazione di lavoro, vedere
“Assistenza per la stazione di lavoro” a pagina 74.

Risoluzione dei problemi con gli indicatori luminosi di stato

Il pannello anteriore include tre indicatori luminosi di stato
che indicano lo stato corrente dello scanner per microarray.

A

n° Ooc'
Indicatori | T A
luminosi — | :
di stato =]

[
Figura 36 Posizione degli indicatori luminosi di stato

La Tabella 3 descrive le azioni che devono essere adottate
sulla base degli indicatori luminosi.
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Stato dei LED Possibili Azione
cause suggerita
Verde Giallo Rosso
Spento Spento Spento Allo scanner non giunge Verificare che:
corrente * I'interruttore di alimentazione
sia attivato
* il cavo di alimentazione sia
connesso e che alla fonte vi sia
corrente
* ifusibili non siano saltati
Lampeggia unavolta Lampeggiauna Lampeggia Test dei LED all'accensione  Non occorre intervenire.
volta una volta (durata < 1 sec.)
Lampeggiante Lampeggiante Spento Ein corso |'autotest Non occorre intervenire. Utilizzare
all’accensione HyperTerminal per acquisire
informazioni diagnostiche. Vedere
“Utilizzo di HyperTerminal per
acquisire dati diagnostici” a
pagina 83.
Spento Lampeggiante Spento Tentativo di connessione al  Installare il software Scan Control
(20 sec. spento/ PC in corso 8.0 qualora questo non fosse gia
20 sec. acceso) installato.
Spento oppure Lampeggiante Spento Download del firmware e Non occorre intervenire.
Acceso (periodo=1,30 inizializzazione DSP in corso
1,0 sec.)
Acceso Acceso Spento | laser si stanno riscaldando  Attendere. Il tempo massimo di
e non sono pronti per la riscaldamento é di 30 minuti.
scansione
Acceso Spento Spento Lo strumento & pronto per Non occorre intervenire.
eseguire la scansione
Lampeggiante Spento Spento Scansione in corso. Non occorre intervenire.
Qualsiasi condizione Qualsiasi Acceso E stato rilevato un errore Contattare il centro vendite e
condizione assistenza Agilent locale.
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AVVERTENZA

Verifica e sostituzione dei fusibili dello scanner

Lo scanner per microarry ha tre fusibili, due per
I’'alimentazione elettrica e uno per il laser a luce rossa. I
fusibili si trovano sul lato posteriore dello scanner per
microarray. I fusibili dell’alimentazione elettrica si trovano
direttamente sopra il cavo di alimentazione. Il fusibile del

laser e inserito in un portafusibili circolare sulla sinistra
della presa del cavo di alimentazione.

I fusibili possono essere ordinati direttamente da Agilent
Technologies.

Disconnettere sempre il cavo di alimentazione prima di controllare o
sostituire i fusibili.

Controllo e sostituzione dei fusibili dell’alimentazione Se lo
scanner per microarray non si accende benché la fonte di
alimentazione sia risultata attiva al controllo, controllare e
se necessario sostituire i fusibili. L’operazione viene eseguita
sul retro dell’'unita.

1 Staccare il cavo di alimentazione.

2 Facendo leva con un piccolo cacciavite piatto, sollevare la
linguetta di plastica sul bordo inferiore del portafusibili
fino a farlo scattare.

3 Estrarre il portafusibili e verificare 'integrita del fusibile.

Se un fusibile & saltato, sostituirlo con un fusibile di
classe T4A, 250 V CA (codice prodotto 2110-1309).

b Reinserire il portafusibili nell’alloggiamento spingendo
fino allo scatto.

6 Inserire il cavo di alimentazione.

Sostituire i fusibili solo con fusibili uguali o di classe equivalente. In
caso di dubbio su quali fusibili utilizzare, contattare il centro vendite e
assistenza Agilent locale prima di eseguire l'installazione.
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5

—— Portafusibili per

I"alimentatore

Figura 37 Estrazione del portafusibili per I'alimentatore

Controllo e sostituzione del fusibile per laser a luce rossa Se lo
scanner per microarray si accende ma il laser a luce rossa
non funziona, & possibile controllare e sostituire senza
difficolta il fusibile del laser operando dal retro dell'unita.

1 Staccare il cavo di alimentazione.

2 Utilizzare un piccolo cacciavite piatto per svitare il
cappuccio circolare in plastica fino a staccarlo.
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Portafusibile
del laser

Figura 38 Portafusibili del laser

3 Estrarre il portafusibili e verificare 'integrita del fusibile.

IS

4 Se un fusibile & saltato, sostituirlo con un fusibile di
classe T500mA, 250 V CA (codice prodotto 2110-0458).

5 Riposizionare il portafusibili e avvitare il cappuccio.

Risoluzione dei problemi del braccio di caricamento automatico
esteso nel caricatore

1 Spegnere lo scanner.
2 Ruotare il caricatore e spingere il braccio fino a riportarlo
in posizione.

Se questo non funziona, contattare il centro vendita e
assistenza Agilent locale per le istruzioni da seguire.

Tentare di rimuovere il caricatore quando il braccio di caricamento
automatico dei portavetrini & esteso nel caricatore puo causare seri
danni allo scanner per microarray.
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Utilizzo di HyperTerminal per acquisire dati diagnostici

Il personale di assistenza Agilent e gli utenti possono
acquisire informazioni per la risoluzione dei problemi dello
scanner impostando una sessione HyperTerminal. Queste
istruzioni si applicano ai sistemi Windows XP. Per istruzioni
sull'acquisizione di dati diagnostici di scanner operativi su
sistemi Windows Vista 32, leggere le note di rilascio fornite
con il software Scan Control versione 8.4.

Impostazione di HyperTerminal

1 Accendere lo scanner per avviare l'inizializzazione.
Avviare il programma Scan Control per accendere i laser.

Assicurarsi che lo scanner sia acceso da almeno 30
secondi prima di avviare HyperTerminal (punto 4).

4 Fare clic su Start > Programmi > Accessori >
Comunicazioni > HyperTerminal.

5 Nella finestra di dialogo Connection Description:

a Digitare Scanner nella casella di testo Name.

Connection Description EJ['E

IQ‘ Mew Connection

Enter a name and choose an icon for the connection:
M ame:
|Scanner |

[ ()8 H Cancel ]

b Fare clic su OK.
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Se lo scanner é acceso e HyperTerminal & in esecuzione, lo scanner

non puo effettuare le procedure di inizializzazione. Attendere almeno
30 secondi dopo aver acceso lo scanner, HyperTerminal deve essere

avviato almeno 30 secondi dopo I'accensione dello scanner.

6 Nella finestra di dialogo Connect To:

a Dal menu a discesa Connect using, selezionare il
numero COMX piu elevato.

In genere si tratta di COM3, ma e possibile verificare
mediante Windows Device Manager. La porta COM dello
scanner € elencata come “USB Serial Port (COMX)”".

Connect To

W Soanner

Enter detailz for the phone number that you want to dial:

Countryfregion; | niied Siates

Area code: ! F L

Fhone number: ! |

Cornectusing: | EXTERM |

[ Ok H Cancel ]

b Fare clic su OK.
7 Dalla finestra di dialogo COMX Properties:

a Selezionare 19200 come Bits per second.

b Selezionare None come Flow Control.
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COM3 Properties

Port Settings |
_ —
Bits per second: l1 5200 |
Data bits: [8 v!
Farity: iT\lone vé
i |
Stop bits: !1 ¥|
Flow conirot: | ET I ~ |
Festore Defaults
0K ] [ Cancel ] [ Apply ]

¢ Fare clic su OK.
Viene visualizzata la finestra Scanner - HyperTerminal.

8 Fare clic su File > Save per salvare il file su Scanner.ht e
chiudere la finestra.

9 Fare clic su Yes alla domande se si desidera interrompere
la connessione.

10 Creare un'icona Scanner.ht di selezione rapida sul desktop:

a Fare clic su Start > Programmi > Accessori >
Comunicazioni.

b Dal sottomenu HyperTerminal, fare clic con il pulsante
destro del mouse su Scanner.ht.

Si noti che il sottomenu HyperTerminal & stato aggiunto
in fondo al menu Communications. Non fare clic con il
pulsante destro del mouse sull’icona del programma
HyperTerminal vicina alla parte superiore del menu.

¢ Dal menu di scelta rapida, fare clic su Create Shortcut.

d Fare clic e trascinare Shortcut to Scanner.ht sul desktop.
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11 Avviare la sessione di cattura testo con HyperTerminal:

a
b

c

Fare doppio clic sull'icona Scanner.ht sul desktop.
Fare clic su Transfer > Capture Text.
Fare clic su Browse.

Nella finestra di dialogo Select Capture File, trovare
I'unita Archive (E:).
Creare una nuova cartella chiamata Support.

Nella cartella Support, creare una nuova cartella e
chiamarla HyperTerminal Capture Files.

Nella cartella HyperTerminal Capture Files, digitare il
nome del file Captureaammgg-n. nella casella di testo
filename, dove aammgg rappresenta la data odierna e
n. rappresenta il numero della sessione di cattura della
giornata.

Fare clic su Save.

Fare clic su Start nella finestra di dialogo Capture Text.

Capture Text A 21 x|

Folder: C:\Documents and Settings\david_baker\tMy

File: Iinal Capture Files\Capture 060105-1. TXT Browse... I
Start I Cancel I

I dati HyperTerminal verranno aggiunti al file finché
HyperTerminal verra chiuso o finché la sessione Capture
Text... verra arrestata dal menu a discesa Transfer.

HyperTerminal si chiudera alla disconnessione.

Avviare una sessione di cattura HyperTerminal dopo la
configurazione iniziale

Se i laser hanno effettuato la procedura di riscaldamento,
passare al punto 3.

1 Accendere lo scanner per avviare l'inizializzazione.

2 Avviare il programma Scan Control per avviare il
riscaldamento dei laser.

3 Fare doppio clic sull’icona Scanner.ht sul desktop.
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4 Dal menu a discesa Transfer di HyperTerminal, fare clic
su Capture Text.

5 Nella finestra di dialogo Capture Text,

a Modificare il nome del file nella casella di testo File in
modo da riflettere la data e la sessione di cattura odierna.

b Fare clic su Start.

Capture Text A 21 x|

Folder: C:\Documents and Settings\david_baker\tMy

Eile: inal Capture Files\Capture 06010E] TXT Browse... I
Start I Cancel I

E anche possibile fare clic su Browse per aprire la finestra
di dialogo Select Capture File. Dalla casella di testo Select
Capture File scegliere una nuova cartella o un nuovo nome
file, altrimenti la sessione di acquisizione originale verra
sovrascritta. Al termine fare clic su Save per continuare.

Risoluzione dei problemi legati al software

Nel caso il computer si rompa o si desideri ricaricare
I'immagine del disco fisso fornita da Agilent con il PC,
Agilent fornisce un CD di recupero che consente di
riattribuire I'immagine al disco fisso.

Per utilizzare il CD & necessario, prima di utilizzarlo,
disconnettere il cavo USB collegato al retro del PC.

Se questo cavo non viene disconnesso, e possibile che le impostazioni
predefinite di Agilent per questi dispositivi USB vengano modificate e
che il software non riconosca lo scanner quando viene riavviato.
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Messaggi di errore dello scanner per microarray

Questa sezione spiega come usare i messaggi di errore che si
possono incontrare.

Sorgenti dei messaggi di errore

Il monitor del computer visualizza messaggi di errore per
I'hardware dello scanner per microarray, il software Scan
Control e Feature Extraction, Microsoft Windows e la stazione
di lavoro. Leggere la barra del titolo del messaggio di errore
per determinare la sorgente del messaggio di errore.

La barra del titolo del messaggio di errore indica che questo
messaggio e correlato all’hardware del caricatore circolare.

Browsing carousel ﬂ

° Description: The chip carousel is not present, Please place the carousel in the scanner and try again,

Figura 39 Barra del titolo di un messaggio di errore di Scan Control

Questo argomento presenta messaggi di errore per ’hardware
dello scanner per microarray e il programma Scan Control.

Se la barra del titolo indica che vi sono problemi con la
stazione di lavoro o Windows, vedere “Assistenza per la
stazione di lavoro” a pagina 74 per informazioni.

Dove possono apparire messaggi di errore relativi allo scanner

I messaggi di errore possono apparire nei seguenti luoghi:

* Gli errori che si verificano durante I'inizializzazione dello
scanner per microarray compaiono nel messaggio Scanner
status nella finestra Scan Control. Vedere “Operazione 4.
Scansione dei vetrini” a pagina 32 al Capitolo 2.

e Gli errori che si verificano prima dell’avvio della
scansione vengono visualizzati in finestre di messaggio.

e Alcuni errori durante la scansione vengono visualizzati nel
messaggio Status nella finestra di dialogo Scan Progress.
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* I messaggi di errore vengono registrati nel log di report
del caricatore circolare mano a mano che il ciclo del
caricatore prosegue. Vedere “Visualizzazione del Carousel
Report Log durante il ciclo” a pagina 41 al Capitolo 2.

Si raccomanda di consultare il log di report almeno dopo
la prima scansione e quando il ciclo del caricatore &
giunto al termine. Il report viene generato
automaticamente alla fine di un ciclo del caricatore.

Risoluzione dei problemi con i messaggi di errore

Lo scanner per microarray Agilent genera messaggi di errore
per aiutare a risolvere i problemi che potrebbero insorgere.
Molti dei messaggi di errore includono una soluzione nella

casella di testo; seguire le istruzioni.

La tabella che segue presenta alcuni dei messaggi di errore
privi di istruzioni. Queste descrizioni contengono informazioni
che possono essere utili per risolvere i problemi.

Messaggio di errore

Descrizione o soluzione

Application Is Already Running
(L'applicazione é gia in esecuzione).

Autofocus error (Errore dell’ Autofocus):

Did not detect two reflective surfaces
during home (Impossibile rilevare due
superfici riflettenti nella posizione
iniziale).

Non é possibile eseguire due copie del programma Scan control
contemporaneamente.

Eseguire quanto segue:

1 Verificare che il vetrino sia inserito correttamente nel portavetrini. Vedere
“Operazione 2. Inserimento dei vetrini nei portavetrini” a pagina 24, oppure
provare un altro portavetrini.

2 \Verificare che il vetrino risponda alle specifiche di Agilent. Vedere “Specifiche
dei vetrini” a pagina 98.

3 Seil problema persiste con un vetrino, & possibile che quel vetrino presenti
dei problemi.

4 Se necessario, selezionare una regione di scansione appropriata. Per alcuni
vetrini non Agilent con bordi traslucidi o opachi, la regione di scansione
selezionata puo essere troppo vicina alle aree non trasparenti del vetro.
Vedere “Creazione di una nuova regione di scansione con Scan Region
Editor.” a pagina 60.

5 Contattare il centro vendite e assistenza Agilent locale.
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Tabellad Messaggi di errore (continua)

Messaggio di errore

Descrizione o soluzione

Autofocus error (Errore dell’ Autofocus). Eseguire quanto segue:
No PSD signal is detected (Non & stato 1 Verificare che il vetrino sia inserito correttamente nel portavetrini. Vedere

rilevato alcun segnale PSD). Make sure “Operazione 2. Inserimento dei vetrini nei portavetrini” a pagina 24.

the”’j Isa SI_'de in the chip holt.ie.r o 2 Verificare che il vetrino risponda alle specifiche di Agilent. Vedere “Specifiche
(Assicurarsi che nel portavetrini vi sia un dei vetrini” a pagina 98.

vetrino). 3 Seil problema persiste con un vetrino, € possibile che quel vetrino presenti

dei problemi.

4 Per alcuni vetrini non Agilent con bordi traslucidi o opachi, la regione di
scansione selezionata puo essere troppo vicina alle aree non trasparenti del
vetro. Vedere “Creazione di una nuova regione di scansione con Scan Region
Editor.” a pagina 60.

5 Contattare il centro vendite e assistenza Agilent locale.

Autofocus was unable to retain focus as  Eseguire quanto segue:
ittravelled to the scan start position 1 Verificare che un codice a barre non abbia ostruito la posizione di inizio

(L' Autofocus non é riuscito a conservare

scansione.

il fuoco mentre si spostava alla posizione 2 gelezionare una regione di scansione pil piccola.

di inizio scansione).

3 Seil problema persiste con un vetrino, € possibile che quel vetrino presenti
dei problemi.
4 Contattare il centro vendite e assistenza Agilent locale.

Cannot eject chip (Impossibile espellere il  Eseguire quanto segue:
vetrino). There is already a chip in the slot 4 Aprire il coperchio dello scanner.
(Esiste gia un vetrino nello slot). 2 Rimuovere il portavetrini dallo slot iniziale.

Cannot load chip, moving the arm may be  Eseguire quanto segue:
unsafe (Impossibile caricare il vetrino, 1 Aprire il coperchio dello scanner.
spostare il braccio potrebbe non essere 3 ge jl braccio del caricatore automatico é gia parzialmente esteso nello

sicuro).

scomparto del caricatore circolare, spostarlo con delicatezza nello scanner
finché si arresta.
3 Seil problema persiste, chiamare il centro vendite e assistenza Agilent locale.

Command timed out (Time out comando). Eseguire quanto segue:

1 Verificare che il cavo USB dallo scanner per microarray alla stazione di lavoro
sia connesso.

2 Spegnere e riaccendere lo scanner per microarray.

Riavviare il programma Scan Control.

4 Seil problema persiste, chiamare il centro vendite e assistenza Agilent locale.

w
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Tabellad Messaggi di errore (continua)
Messaggio di errore Descrizione o soluzione
Connection manager reports that there Tra le cause possibili per questo errore vi sono:
are no instruments (Il CO“"‘?CUO" * Lo scanner per microarray potrebbe non essere acceso oppure lo scanner per
Manager.rlferlsce che non vi sono microarray & stato acceso ma non & trascorso un tempo sufficiente affinché lo
strumenti). scanner per microarray abbia completato |'autotest e |'inizializzazione.

Selezionare OK per chiudere il messaggio Scan Control, attendere alcuni

minuti e riprovare.

» Lo scanner per microarray potrebbe non essere connesso alla stazione di
lavoro. Verificare che il connettore USB sia connesso allo scanner per
microarray e alla stazione di lavoro. Se il connettore USB é disconnesso,
riconnettere il cavo, riavviare il computer e, se necessario, spegnere e
riaccendere lo scanner per microarray.

* Le proprieta di networking del protocollo Internet (TCP/IP) dello scanner
potrebbero essere state alterate. Verificare che I'indirizzo IP della Local Area
Connection dello scanner sia 10.0.0.1 e che la maschera di sottorete sia
255.255.255.0.

» E possibile che il firewall di Windows XP impedisca la comunicazione.
Disabilitare il firewall.

+ Selastazione dilavoro ¢ stata riavviata, potrebbe essere necessario spegnere
e riaccendere lo scanner per microarray dopo il riavvio di Windows.

Error ejecting chip (Errore nell'espulsione  Eseguire quanto segue:
del vetrmg)._ll_ vetrino é stato espulso 1 Spegnere lo scanner.
nello slot iniziale. 2 Aprire il coperchio dello scanner.

3 Ruotare il caricatore circolare a mano fino a che lo slot iniziale non & bloccato
dal braccio del caricatore automatico.

4 Rimuovere il coperchio dallo slot iniziale.

5 Riportare dolcemente il braccio del caricatore automatico nello scannerfino a
che si arresta.

6 Seil problema persiste, chiamare il centro vendite e assistenza Agilent locale.

Failed to communicate with connection Eseguire quanto segue:
manager (Impossibile comunicare conil 1 Riayviare la stazione di lavoro.
Connection Manager). 2 Spegnere e riaccendere lo scanner per microarray.
3 Dopo parecchi minuti, avviare il programma Scan Control.
Lasers never became ready (I laser non Eseguire quanto segue:
diventano mai pronti). 1 Verificare che il numero visualizzato sul selettore di tensione sul retro dello
scanner corrisponda alla tensione erogata.

2 Se la stazione di lavoro é stata riavviata, potrebbe essere necessario
spegnere e riaccendere lo scanner per microarray dopo il riavvio di Windows.

3 Seil problema persiste, chiamare il centro vendite e assistenza Agilent locale.
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Tabellad Messaggi di errore (continua)

Messaggio di errore

Descrizione o soluzione

Missing or corrupt ChipRegions.ini file
(File ChipRegions.ini assente o
danneggiato).

Not enough disk space to create file (Lo
spazio su disco non é sufficiente per
creare il file).

PMT calibration may be unstable (La
calibrazione PMT potrebbe essere
instabile). Using last known PMT setting

(Utilizzare I'ultima impostazione PMT nota).

PMT calibration lost! (La calibrazione
PMT é andata persa!) Using factory
default settings (Vengono utilizzate le
impostazioni predefinite di fabbrica).

Slide skipped because it is outside the
allowable thickness range or the selected
scan region contains an obstruction to the
initial focus positions (Il vetrino € stato
saltato perché é al di fuori dell'intervallo di
spessore ammesso oppure la regione di
scansione selezionata contiene un’ostruzione
alle posizioni di fuoco iniziali).

The autoloader loading arm is in an
unknown location (Il braccio di
caricamento automatico si trova in una
posizione sconosciuta). Itis unclear if it is
safe to move the carousel (Non é chiaro
se e sicuro muovere il caricatore
circolare).

Eseguire quanto segue:

1 Se si dispone di una copia di back-up del file ChipRegions.ini, copiarla in C:\Program
Files\Agilent\Microarray. Il fatto di disporre di una copia del file ChipRegions.ini
evita la perdita e la necessita di ricreare regioni di scansione personalizzate.

2 Se non si dispone di una copia di back-up, cercare il file ChipRegions.bak
nella cartella e rinominarlo ChipRegions.ini.

3 Se manca anche questo file, reinstallare il programma Scan Control.

4 Contattare il centro vendite e assistenza Agilent locale.

Il disco fisso non ha spazio a sufficienza per creare un file dove archiviare i dati di
scansione. E possibile adottare una delle soluzioni seguenti:

+ accedere al menu principale di Scan Control e impostare la directory di output
su un’altra directory su un altro disco fisso.

» Cancellare o trasferire i file dal disco fisso corrente. Vedere “Operazione 5.
Trasferimento dei file e archiviazione dei dati” a pagina 42.

E possibile reimpostare questo messaggio di errore utilizzando lo strumento
Reset Calibration Warnings. Vedere “Strumenti aggiuntivi” a pagina 65. Se il
messaggio persiste o si ripete, contattare il centro vendite e assistenza Agilent
locale.

E possibile reimpostare questo messaggio di errore utilizzando lo strumento
Reset Calibration Warnings. Vedere “Strumenti aggiuntivi” a pagina 65. Se il
messaggio persiste o si ripete, contattare il centro vendite e assistenza Agilent
locale.

Eseguire quanto segue:

1 Verificare la presenza sul vetrino saltato di un codice a barre, di residui di
ibridazione o di un’altra ostruzione non trasparente che possa interferire con
la posizione di fuoco iniziale. La posizione di fuoco iniziale primaria si trova 1 -
2 mm sulla sinistra della regione di scansione sulla riga piu alto della regione
di scansione.

2 Misurare lo spessore del vetro e verificare che soddisfi le specifiche in
“Specifiche dei vetrini” a pagina 98.

Eseguire quanto segue:

1 Aprire il coperchio dello scanner.

2 Seil braccio del caricatore automatico é gia parzialmente esteso nello
scomparto del caricatore circolare, spostarlo con delicatezza nello scanner
finché si arresta.

Chiudere e quindi riavviare il programma Scan Control.

4 Seil problema persiste, chiamare il centro vendite e assistenza Agilent locale.

w
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Manutenzione e risoluzione dei problemi del sistema

Tabellad Messaggi di errore (continua)

5

Messaggio di errore

Descrizione o soluzione

The chip carousel is not present (Il caricatore
circolare di vetrini non é presente). Please
place the carousel in the scanner and try
again (Riposizionare il caricatore circolare
nello scanner e riprovare).

The carousel may be misaligned (Il
caricatore circolare potrebbe essere
disallineato). Please remove the carousel,
make sure that its opening is aligned with
home position and reinsert the carousel
(Rimuovere il caricatore circolare,
assicurarsi che I'apertura sia allineata con la
posizione iniziale e reinserire il caricatore).

The slide failed to eject (Il vetrino non &
stato espulso). Pressing OK will
re-initialize the instrument (Premere 0K
per inizializzare nuovamente lo
strumento).

The software has detected a serious
sensor error that may have existed prior
to the installation of this version of
software (Il software ha rilevato un grave
errore del sensore che é possibile
esistesse prima dell’installazione di
guesta versione del software).

Unable to lock instrument specified by
connection manager (Impossibile
bloccare lo strumento specificato dal
Connection Manager).

Inserire il caricatore circolare nello scanner per microarray e riavviare il ciclo del
caricatore. Vedere “Operazione 2. Inserimento dei vetrini nei portavetrini” a
pagina 24.

Vedere “Operazione 2. Inserimento dei vetrini nei portavetrini” a pagina 24.

Quando si preme 0K, lo scanner per microarray ripete I'inizializzazione. Se
questa non riesce, eseguire quanto segue:

1 Aprire il coperchio dello scanner.

2 Seil braccio del caricatore automatico e gia parzialmente esteso nello
scomparto del caricatore circolare, spostarlo con delicatezza nello scanner
finché si arresta. Non forzarlo se non si muove agevolmente.

3 Chiudere e quindi riavviare il programma Scan Control.

4 Seil problema persiste, chiamare il centro vendite e assistenza Agilent locale.

Contattare il centro vendite e assistenza Agilent locale.

Eseguire quanto segue:

1 Riawviare la stazione di lavoro.
2 Spegnere e riaccendere lo scanner per microarray.
3 Awviare il programma Scan Control.
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5 Manutenzione e risoluzione dei problemi del sistema

Tabellad Messaggi di errore (continua)

Messaggio di errore

Descrizione o soluzione

You must select a region to scan first
(Prima selezionare una regione da
scansire).

You must select at least one dye channel
(Occorre selezionare almeno un canale di
colorazione).

You must close the door first (Chiudere
prima lo sportello).

Warning (Avvertenza): The laser power
does not fall within expected thresholds
(La potenza del laser non rientra nei limiti
attesi). Please contact an Agilent
representative (Contattare un
rappresentante Agilent).

Per inserire una regione di scansione non specificata nel profilo selezionato
nella tabella di scansione:

1 Selezionare lo slot o gli slot per i quali si desidera immettere la regione.

2 Fare clic sulla freccia verso il basso accanto alla selezione.

3 Selezionare una regione di scansione dalla lista delle regioni di scansione. Vedere
“Modifica delle impostazioni individuali della tabella di scansione” a pagina 46.

4 Avviare la scansione o il ciclo del caricatore circolare.

1 Selezionare lo slot o gli slot di cui si desidera modificare il canale di colorazione.
Fare clic sulla freccia verso il basso accanto alla selezione.

3 Selezionare un'impostazione del canale di colorazione dalla lista. Vedere
“Dye channel” a pagina 49.

L'inizializzazione dello scanner per microarray e le operazioni di scansione non
possono essere eseguite con il coperchio dello scanner per microarray aperto.
Chiudere il coperchio.

Attendere il periodo di riscaldamento necessario (circa 30 minuti) quando il
messaggio di stato nel programma Scan Control visualizza Status Ready. E
possibile reimpostare questo messaggio di errore utilizzando lo strumento Reset
Calibration Warnings. Vedere “Strumenti aggiuntivi” a pagina 65. Se il messaggio
persiste o si ripete, contattare il centro vendite e assistenza Agilent locale.

Il programma Scan Control scala il file TIFF per compensare la potenza inferiore dei laser.

Se un messaggio di errore non compare nella tabella

Questa tabella non elenca tutti i possibili messaggi di errore.
Nel caso compaia un messaggio di errore non elencato e non
si riesca a risolvere il problema, comportarsi come segue:

1 Scrivere il messaggio di errore.

2 Riavviare il programma Scan Control.

3 Se il punto 2 non risolve il problema, comportarsi come segue:
a Riavviare la stazione di lavoro.
b Spegnere e riaccendere lo scanner per microarray.
¢ Riavviare il programma Scan Control.

4 Se il punto 3 non risolve il problema contattare il centro
vendite e assistenza Agilent locale.
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Specifiche dello scanner per
microarray
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Agilent G2565CA Scanner per microarray
(Software Scan Control 8.3)
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Consultazione

Specifiche dello scanner per microarray 96
Specifiche dei vetrini 98

Informazioni normative 102

Controllo della tensione di ingresso 105

Questo capitolo include specifiche, informazioni normative e

istruzioni per il controllo della tensione se si sposta lo

strumento.

Questa sezione descrive le specifiche dello scanner per

microarray. Per le specifiche della stazione di lavoro, vedere

la guida all’'uso fornita con il PC.

Questa sezione presenta le specifiche per i vetri e il codice a

barra che lo scanner puo accettare.

Questa sezione riporta le normative sulle emissioni acustiche,
il riciclaggio e lo smaltimento, l'interferenza elettromagnetica e

la sicurezza a cui lo scanner per microarray € conforme.

In questa sezione e possibile assicurarsi che la tensione di
ingresso & corretta dopo uno spostamento.

: Agilent Technologies
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6 Consultazione

Specifiche dello scanner per microarray

Dimensioni
approssimative

Peso

Tensione in
ingresso

Fusibili

Intervallo di
temperatura

Umidita

Altitudine

Utilizzo

Informazioni sul
laser

Lo scanner per microarray opera nel contesto delle seguenti
specifiche:

Altezza: 97 cm; altezza con il coperchio chiuso, 55 cm
Larghezza: 91 cm
Profondita: 71 cm

Queste dimensioni si riferiscono all’altezza e alla larghezza
massime quando le porte sono aperte e a uno spazio di 80 mm
(3") di profondita necessari per una ventilazione adeguata.

99 Kg
100, 120, 220, 0 240 V CA a 4 A
50/60 Hz

Due fusibili per I'alimentazione: T4A, 250 V CA (codice
prodotto 2110-1309)

Un fusibile per il laser: T500mA, 250 V CA (codice prodotto
2110-0458)

In funzione: da 15° a 30°
Conservazione: da -20° a +50°
In funzione: 15% - 95% umidita relativa a 30°C

Potenzialmente sensibili a condizioni di umidita con generazione
di condensa. Seguire le precauzioni indicate nel Capitolo 5.

Massima in funzione: 2.300 m
Massima di conservazione: 4.600 m
Utilizzo in ambienti chiusi

Lunghezze d’onda di eccitazione:
¢ Laser SHG-YAG: 532 nm

e Laser elio-neon (HeNe): 633 nm

Potenza: 20 mW a 532 nm e 23 mW a 633 nm, entrambi
controllati a 13 mW
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Regione di
scansione massima

Regione di stampa del
microarray suggerita

Colorazioni
ammesse

Risoluzione
(dimensioni dei pixel)

Errore di
posizionamento pixel
Uniformita

Tempo di scansione

Intervallo dinamico

Consultazione 6

Agilent G2565CA: 71 mm x 21,6 mm

1 mm piu piccola della regione di scansione sulla destra, 2
mm sulla sinistra e 0,6 mm in alto e in basso. Per i vetrini
non Agilent, la regione di stampa e piu piccola di questa di
una quantita uguale alla tolleranza di stampa dell’array.

Cianina 3 (Cy-3) e cianina 5 (Cy-5) e colorazioni simili a
Cy-3 e Cy-5 e colorazioni Alexa 647, 555, 660

2, 3, 5 0 10 micron

< 1 pixel a una risoluzione di 5 micron

non uniformita globale 5% CV, la non uniformita locale
media p tipicamente pari a 1% su tratti di 100um.

Tabella5 Tempo di scansione per scansioni con passata singola e doppia
per la regione di scansione Agilent HD 61 x 21,6 mm

Risoluzione Tempo di scansione,
min.

Passata singola a 2 micron 20

Passata singola a 3 micron 15

Passata singola a 5 micron 8

Passata singola a 10 micron 8

Passata doppia a 2 micron 40
Passata doppia a 3 micron 30
Passata doppia a 5 micron 16

Intervallo dinamico a 16 bit per singola scansione >10%
Intervallo dinamico a 20 bit per singola scansione >10°

Intervallo dinamico esteso di scansione doppia (XDR) > 108
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Specifiche dei vetrini

dimensioni di scansione

La regione di scansione e specificata nella Figura 40. Tutte
le dimensioni sono in millimetri e il punto di riferimento &
I'angolo in basso a destra del vetro.

- 76.2 +0.25 -1.4 >
]
—
©
o
254 +0.7 ©
or-0.45 é
| I
g 216
%)
—_
©
m
_ v
¥ —1.9
‘ 61.0 ‘
4>‘ ‘ F ‘ \‘ 600 ;‘ f-—
1.0 4.0 J
42

Figura40 Regione di scansione per Agilent G2565CA

Specifiche del vetro

Lo scanner per microarray utilizza portavetrini per spostare
i microarray dentro e fuori il caricatore circolare. Questi

portavetrini sono concepiti per accogliere un pezzo di vetro
nominale di 1" x 3".

Le specifiche dettagliate del vetro sono le seguenti:
e 1” di larghezza (25,4 mm, -0,45 mm o +0,7 mm)
e 3” di lunghezza (7,62 mm, +0,25 mm o -1,4 mm)

e 1 mm di spessore (+/-0.1 mm)

No vetrini specchiati

Elevata qualitd con fluorescenza intrinseca ridotta
Indice di rifrazione da 1,510 a 1,515.
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Specifiche dei codici a barre e delle etichette con codice a barre

Specifiche dei codici a barre per i vetrini Agilent

Lo scanner G2565CA legge i codici a barre posizionati sul
lato attivo dei vetrini.

Per garantire la compatibilita retroattiva con gli scanner
modello G2565AA, i microarray Agilent continuano ad avere
i codici a barre su entrambi i lati. L'etichetta con il testo
“Agilent” indica il lato attivo; l'etichetta con il valore
numerico indica il lato inattivo.

Double-barcoded slide example

=
=l
SIDE 1 £ = Inactive Glass Surface
S
|
=
i . .
= = Active Active
SIDE 2 §= Microarray Microarray
2= Surface Surface
u
=

Figura41 Orientamento del codice a barre sul vetrino Agilent rispetto
alla superficie del microarray

Specifiche dei codici a barre per i vetrini non Agilent

¢ Lo spessore massimo dell’etichetta del microarray e 0,2
mm. Assicurarsi che nell’etichetta non vi siano bolle. Non
aggiungere etichette su etichette vecchie o sostituire le
etichette che cominciano a staccarsi.

¢ Non collocare etichette con codici a barre su vetrini la cui
regione di scansione supera i 61 mm. Inserire
I'identificatore del vetrino o il codice a barre manualmente
per i vetrini la cui regione di scansione supera i 61 mm.
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¢ Per un vetrino con codice a barre, la distanza tra il bordo
della regione di scansione del microarray e il bordo del
codice a barre non puo essere inferiore a 4 mm.

Fre = = = — = = = a9 ]
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\ \ E
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Regione di scansione k]
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2
| |8
Lo . g
>4 mm

Figurad42 Posizione del codice a barre su vetrini non Agilent

¢ La larghezza del codice a barre deve essere di circa 6 mm;
la larghezza raccomandata del codice a barre & destinata
a una regione di scansione di 61 mm. Etichette con codici
a barre piu larghe o piu lunghe possono essere utilizzate
riducendo proporzionalmente la regione di scansione.

¢ Le etichette con codici a barre devono essere sufficientemente
stretti da non interferire con le linguette del portavetrini.

¢ L’inclinazione massima ammessa nel posizionamento
dell’etichetta con il codice a barre sul vetrino & di *3°.
Il codice a barre deve soddisfare i seguenti requisiti:

¢ La zona silenziosa minima (la regione tra il bordo
dell’etichetta e I'inizio o la fine del codice a barre) e 10
volte la dimensione di X su ciascun lato del codice a barre.

* Le linee del codice a barre devono essere parallele al bordo
lungo del vetrino con una tolleranza di inclinazione di +3°.

¢ Agilent supporta i seguenti formati di codice a barre:

Code 128: i codici a barre non Agilent con 12 cifre non
devono cominciare con 2

CODABAR: massimo 8 cifre; spessore minimo della
linea = 6 mil
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Code 39: massimo 8 cifre; spessore minimo della linea
= 6 mil

Code 93: massimo 8 cifre; spessore minimo della linea
= 6 mil

e L’altezza minima del codice a barre deve essere

Code 128: 15% della lunghezza del codice a barre per il
Codice 128

Code 39, Code 93, CODABAR: 5 mm o 15% della lunghezza
del codice a barre, a seconda di qual e il maggiore
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Informazioni normative

Inglese

Deutsch

Per maggiori informazioni sul
riciclo e lo smaltimento, contattare

Agilent Technologies.

102

Emissioni

Immunita

Questa sezione riporta le informazioni normative riguardanti
lo scanner per microarray.

Destinato esclusivamente a scopi di ricerca

Lo scanner per microarray Agilent G2565CA e destinato
ESCLUSIVAMENTE A SCOPI DI RICERCA.

Informazioni sulle emissioni acustiche
Dichiarazione del produttore:

This statement is provided to comply with the requirements
of the German Sound Emission Directive, from 18 January
1991. Sound Pressure Lp < 70 dB(A), at operator’s position,
normal operation, according to EN 27779 (Type Test).

Die folgende Information wird in ["Jbereinstimmung mit den
Anforderungen der Maschinenldrminformationsverordnung
vom 18. Januar 1991 erteilt. Schalldruckpegel am
Arbeisplatz bei normalem Betrieb, Lp < 70 dB(A), nach EN
27779 (Typprifung).

Riciclo e smaltimento

Questa unita e concepita per il riciclo al termine della sua vita
utile. Smaltire 1'unita nel rispetto delle disposizioni locali.

Interferenza elettromagnetica

Lo scanner & progettato per essere usato esclusivamente con
cavi schermati.

Rispetta i livelli di emissioni per le attrezzature di Classe A
come stabilito dalla norma 1EC 61326-1. Questa attrezzatura
non ¢ destinata all'uso in aree residenziali.

Questo dispositivo € conforme ai livelli di immunita imposti
dalla norma IEC 61326-1 per un ambiente non controllato,
non industriale. Per i livelli specifici vedere 1'allegata
Dichiarazione di Conformita.
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Canada Questo dispositivo ISM (Industriale- Scientifico- Medico)
soddisfa la norma canadese ICES-001.

Cet appareil ISM est conforme a la norme NMB-001 du Canada.

Informazioni sulla sicurezza

Questo scanner soddisfa i seguenti standard di sicurezza:

CAN/CSAN. C22.2 Safety Requirements for Electrical

N.1010.1-92 Equipment for Measurement, Control, and
Laboratory Use, Part 1: General Requirements
(Incluso Emendamento 1)

CAN/CSA-C22.2 Emendamento 2 alla norma CAN/CSA-C22.2
N.1010.1B-97 N.1010.1-92, Safety Requirements for Electrical
Equipment for Measurement, Control, and
Laboratory Use,
Part 1: General Requirements

UL Std N. 3101.1 Electrical Equipment for Laboratory Use:
Part 1: General Requirements
UL Std N. 3111-1 Equipment for Measurement Use;
Part I: General Requirements
ISA S82.01-1994 Safety Standards for Electrical and Electronic

Test, Measuring, Controlling, and Related
Equipment - General Requirements

IEC 61010-1 Safety Requirements for Electrical Equipment for
Measurement, Control, and Laboratory Use,
Part 1: General Requirements

IEC 825-1 Safety of laser products Part 1: Equipment
classification, requirements and user's guide.

EN60825-1

(Incluso Emendamento 1:1992 ed Emendamento 2:1995)
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¢ Livello di inquinamento: 2

e (Categoria di installazione: II

* Attrezzatura di Classe 1; richiede un sistema di messa a terra
* Prodotto laser di Classe 1

¢ Prodotto approvato UL/CSA
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Controllo della tensione di ingresso

Verifica della tensione di ingresso

Consultazione 6

Se si accende lo scanner per microarray per la prima volta o
dopo averlo trasferito in un nuovo sito, € necessario dapprima
verificare che la tensione di ingresso riportata sul retro
dell’apparecchio sia impostata sul valore corretto. La tensione di
ingresso puo essere impostata su uno dei quattro valori seguenti:

N

100 V CA
120 V CA
220 V CA
240 V CA

Controllare il retro dello scanner per microarray.

Verificare 'impostazione della tensione di ingresso
attraverso la finestrella.

' —

=
{ < 0

=

Figura 43

di ingresso

Finestrella per la
verifica
dell’impostazion
e della tensione
di ingresso

Finestrella per la verifica dell'impostazione della tensione

3 Se 'impostazione della tensione di ingresso corrisponde
alla tensione di rete, & possibile accendere lo scanner per
microarray senza pericolo.

Se I'impostazione della tensione di ingresso non
corrisponde alla tensione di rete, modificare le
impostazioni di tensione.
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Modifica dell’'impostazione di tensione

1 Staccare il cavo di alimentazione.

AVVERTENZA Staccare sempre il cavo di alimentazione prima di modificare

I'impostazione della tensione di ingresso.

2 Facendo leva con un piccolo cacciavite piatto, sollevare la
linguetta di plastica sul bordo inferiore del portafusibili
fino a farlo scattare.

Portafusibili

Figura44  Estrazione del portafusibili per I'alimentatore

3 Estrarre il portafusibili.
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4 Utilizzare una pinza a becco fine per rimuovere il
selettore di tensione.

Selettore di tensione

\4 > Portafusibili

Figura45 Rimozione del selettore di tensione dal portafusibili

5 Inserire il selettore di tensione in modo che il numero
visibile corrisponda alla tensione di rete.

6 Reinserire il portafusibili nell’alloggiamento spingendo
fino allo scatto.

7 Inserire il cavo di alimentazione.
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Modifica dell’impostazione di tensione
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